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Guard1 Plus 

Welcome to Guard1 Plus 

Congratulations on selecting Guard1 Plus! We're sure you will find that Guard1 Plus is easy to use for your basic 
guard tour needs. As you learn more, you will become familiar with the many useful and sophisticated features it has 
to offer. Guard1 Plus is serious guard tour software for security professionals. 

Here are some of the many features in Guard1 Plus (some features require add-on modules or Microsoft Word): 

• It's easy to get started quickly. Wizards help you add information about your clients, their facilities, and more. 

• It's easy to set up your initial locations or add new locations. Guard1 Plus recognizes new buttons (or stations) 
automatically as you download them. The Assign Names Wizard helps you set these up quickly. 

• It's easy to add your first reader or additional readers. Just connect your downloader to the computer and run the 
Add Devices Wizard. The wizard automatically detects THE PIPE or any other readers you are using. 

• Versatile hardware support. In addition to THE PIPE from TimeKeeping Systems, Guard1 Plus supports readers 
from Detex/GCS, Morse Watchman’s, and Deister Electronic. If you have readers from one of these manufacturers, 
you can use your existing equipment for now, and move up to THE PIPE when you're ready. 

• The Attendant handles communication with THE PIPE and other readers even when Guard1 Plus is not running. 

• Guard1 Plus and the Attendant automatically detect THE PIPE and other readers, twenty-four hours a day. Just put 
the reader in its downloader and Guard1 Plus does the rest. Your officers can download their own readers without 
any need to use the computer. 

• Guard1 Plus supports remote downloading, and it's easy to set up and use. The Add Devices Wizard will find your 
modem, and automatically dial and configure Guard1 Plus for your remote equipment. 

• Rules-based data architecture. While rules can accommodate traditional "tours" or "patrols", they are much more 
flexible. Rules give you greater freedom in determining where your officers are expected to be, and when. 

• Guard1 Plus prints twenty different reports, covering all your analysis and reporting requirements. 

• You can set up the reports you print regularly or occasionally, and save them as custom reports. Or, you can 
combine many reports and print them together with a single selection. This batch report feature is ideal if you print 
several reports regularly for clients or for internal use. 

• Reports are attractive and professional in appearance using the formatting features of Microsoft Word. It's easy to 
set up your report's appearance using one of the report templates provided. 

• You can select to automatically print cover sheets and title pages for report presentations or faxes. 

• You can even add pictures for each location and maps showing routes and locations, and print this as a guide to 
show new officers exactly where to go and what to do. 

• Password protection ensures that Guard1 Plus will only be accessible to authorized users. 

• For users of our earlier Guard1 program, a Guard1 to Guard1 Plus Conversion Wizard is available. 

• Best of all, because of our unique software activation process, you can try all Guard1 Plus features at no charge for 
thirty days. 
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 Introduction - How to get started 

Guard1 Plus is a comprehensive guard-tour software package that provides a long list of features. You can connect 
and download guard-tour devices (readers and downloaders) from several manufacturers, you can print a variety of 
reports after downloading patrol data, you can view the data on screen, and you can set numerous options to 
configure Guard1 Plus to best suit the way your organization works. 

 Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 

Guard1 Plus uses a number of software wizards that provide assistance with installing devices, adding locations, 
officers and incidents, adding and configuring clients, facilities and groups, and managing and maintaining your patrol 
data. 

Guard1 Plus includes a sample data file, so you can experiment with the program and learn about its features before 
adding your own buttons, clients, etc. This sample patrol data demonstrates the set up of clients, facilities and groups 
and includes a number of downloads. You can download additional patrol data into the sample data if desired, and 
print reports of the sample data. However, you should not download important tour data into the sample data file. Use 
this only for training and exploration purposes. 

Reports are highly configurable. With the Rules and Advanced Reports module, you can create "rules" that are 
applied to your patrol data. This allows the creation of custom reports that will include exactly the patrol information 
you or your clients want. Many styles of reports are available using Microsoft Word and Word templates for printing. 
These allow the inclusion of company logos (either your own organization’s, your clients’, or the standard Guard1 Plus 
logo), watermarks, and other styles. 

Guard1 Plus includes extensive on-line help. This is the "manual" for your software. To view the on-line Help select the 
Help  menu, then select Help Topics. The Guard1 Plus Help window will open. 

Tell me more about using Help.  

Guard1 Plus is modular. During the trial period you have full use of all modules. When the trial period expires the 
software must be activated. The Basic System may be activated at no charge. The activation of other modules is sold 
on a per-module or per-system basis. 

Several steps are required to set up your devices and the Guard1 Plus software before you can start downloading 
patrol data. 

 

What's new  with GUARD1 PLUS 3.02 

IN GUARD1 PLUS 3.02 the database engine is a single user SQL application instead of an ACCESS database as in 
earlier GUARD1 PLUS releases. SQL provides a more robust database ensuring data integrity as the database 
continues to grow in size. GUARD1 PLUS includes a Database Import Wizard which will import the GUARD1 PLUS 
2.xx databases into the master database  for GUARD1 PLUS release 3.02.  For further information on the Database 
Import Wizard go to page 4 .  

About the icons and tabs 

Guard1 Plus uses many icons to indicate the functions of the various buttons and tabs in the program. The main 
application window has a toolbar across the top. Each properties tab also has its own toolbar. These toolbars are rows 
of small buttons whose functions are identified with small icons. There are two ways to learn what each button does: 

  Tool Tips. If you "hover" the mouse pointer over a toolbar button, a small balloon will appear with the name of that 
button. Often this is all you’ll need to understand that button’s purpose. 

  What’s This Help. If you want to know more about a toolbar button, select the What’s This Help  button  on the 
main toolbar. In dialog boxes select the What’s This Help button  in the top-right corner of the dialog. The cursor will 
change to indicate it’s in What’s This Help mode. Select the button about which you want more information. A 
window will appear explaining the function of the button you selected. Select the window to close it. 

Though it does not have a toolbar, you can still access What’s This Help for the Attendant: 

1 Right-click the Attendant’s icon . This is located near the clock on your Windows taskbar. 

2 A menu will pop up. Select Options  from the menu. 

3 The Attendant’s window will appear. Select the What’s This Help  icon  at the top-right of the window. 

4 Select the button or check box about which you want more information. A window will appear explaining the button 
or check box you selected. 

5 Select the help window to close it. 

6 Select the OK  button to close the Attendant. 

What’s This Help is available for almost every button, field, check box, icon, and tab in Guard1 Plus and the 
Attendant. 

 to get more help. 
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How to get more help 

Guard1 Plus has an extensive on-line Help system. This is the "manual" for your software. To view the on-line Help 
select the Help  menu, then select Help Topics. The Guard1 Plus Help window will open. You can browse the 
Contents tab, view the index, and search for topics using the three tabs above the left pane of the Help window. 

You can resize the Help window as you would any other window. You can change the width of the right and left panes 
of the Help window by dragging the divider. 

 

 

To find a Help topic: 

1 In Help, select one of the following tabs: 

  To browse through topics by category, select the Contents tab. 

  To see a list of index entries, select the Index tab, and then either type a word or scroll through the list. 

  To search for words or phrases that may be contained in a Help topic, select the Search tab. 

2 In the left pane of the Help window, select the topic, index entry, or phrase to display the corresponding topic in the 
right pane. 

To get more out of Help: 

In a Help topic, you can select underlined words to see other information related to the topic. 

  To see the definition of a term with a dotted underline, select it. Try it here to see the definition of Basic System and 
then click again to make the definition disappear. 

  To select other topics containing related information, select the solid underlined words. Try it here to see the 
Welcome to Guard1 Plus topic, then select the Back button to return to this topic. 

The See Also button at the top of the Help window is available in many help topics. Select this button to see a menu of 
related topics. Select from the menu to see a related topic. 

To copy a Help topic: 

1 In the right pane of the Help window, right-click inside the topic you want to copy, then select Copy. 

This copies the topic to the Clipboard. 

2 Open the document where you want the topic to appear. 

3 Click the place in your document where you want the information to appear. 

4 On the Edit menu, click Paste.  

 If you want to copy only part of a topic, drag to select the part you want to copy, right-click your selection, and then 
select Copy. 

To print a Help topic: 

  While viewing the topic you want to print, select the Print button at the top of the Help window. 

  To print a pop-up topic, right-click inside the pop-up window, and then select Print Topic…. 

What’s This Help: 

Guard1 Plus provides extensive What’s This Help. If you want to know more about a toolbar button, field, check box, 
icon, or tab: 

1 Select the What’s This Help  button  on the main toolbar. In dialog boxes and the Attendant, select the What’s This 
Help button  in the top-right corner of the dialog. The cursor will change to indicate it’s in What’s This Help mode. 

2 Select the button, field, or other control about which you want more information. A small window will appear 
explaining the function of the button you selected. 

3 To print or copy a What’s This Help topic, right-click inside the topic and make your choice from the menu that 
appears. 

4 Click to close the What’s This Help window. 

More Help: 

The dialog boxes and Wizard panels in Guard1 Plus have Help buttons. Select the button for Help with the dialog box 
or Wizard panel. 

On each properties tab you’ll find a Quick Help  icon  button. Select this button for Help with all of the buttons, fields, 
and other controls on the tab. 

Guard1 Plus gives you quick access to the Guard1 Plus Web site. If you have Internet access, establish a connection 
as required by your system, then select the Home Page  button  on the Guard1 Plus toolbar. At this site you’ll find 
information about available software modules, THE PIPE and downloaders available from TimeKeeping Systems, and 
any late-breaking news, tips, frequently asked questions (FAQ), etc. about Guard1 Plus. You’ll also find links to email 
for Sales and Technical Support, as well as telephone and fax numbers. 
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When Guard1 Plus starts it will display a Tip of the Day. This offers helpful information and tips about using the 
program. You can view additional tips by selecting Next Tip. Select OK to close the Tip window. 
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How Guard1 Plus is organized 

Guard1 Plus is organized much like the Windows Explorer that is part of Windows. This helps to make Guard1 Plus 
easy to learn. Information is displayed in Guard1 Plus in a hierarchy, or indented treeview listing. The branches of the 
tree are called nodes. The left pane of the window displays the treeviews for various items in Guard1 Plus, and the 
right pane is used to display the properties of these items. Show me. You can change the width of these panes by 
dragging the divider between the panes. This will allow you to see long names of clients, reports, etc. 

The main screen in Guard1 Plus uses a series of tabs, appearing in a row across the top of the left pane of the 
window. These tabs determine which part of the program you interact with at any given time. Selecting any tab will 
bring it to the top so you can view lists and use the tools available there. The tabs are: 

• Facilities: This is the tab that appears "on top" when Guard1 Plus is started (unless you have reports-only access). 
Clients, facilities, groups, and locations appear under this tab. The tools you will use to create and maintain these 
are available here. 

• Reports: You’ll see a list of the available reports displayed under this tab. Reports that are dimmed are disabled, 
but become activated when you purchase the Rules and Advanced Reports module. If you have reports-only 
access to Guard1 Plus, this is the only tab that will appear. 

• System: You will find your devices listed under this tab, as well as software modules and technical support 
information. Software modules that are dimmed are disabled, but become activated when you purchase the 
respective module. 

• Downloads: When readers are downloaded, the individual downloads appear under this tab. You can see the date 
and time and view additional information for each download. 

• Buttons: All buttons added to Guard1 Plus appear under this tab. Buttons can be assigned one of four types: 
locations, incidents, officers, and unassigned. You determine the type when you add a button. 

• Keypads: All keypads added to Guard1 Plus appear under this tab. The Keypad Module allows setting up numeric 
button keypads for use with THE PIPE. Keypads contain 12 touch buttons that represent the digits 0 through 9, plus 
Enter and Cancel keys. The Keypad Module can be disabled. The tab will not appear when the module is disabled. 
Also, keypads are available only during the trial period or after you have activated the Keypad Module. 

Tell me more about button types.  

 Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 

In addition to these tabs, you’ll find the main menu bar at the top of the window, as usually found in Windows 
applications. Below that is a row of buttons that help you navigate through the various lists that can be displayed, and 
get help from Guard1 Plus’s extensive on-line help system. At the bottom of the window is a status bar. This shows the 
current date and time as set in your Windows Date/Time control panel, and also shows the status of Guard1 Plus. It 
will display status messages, the number of items in button lists and downloads, etc. 

Like Windows itself, Guard1 Plus makes extensive use of "right-click" context menus. These are pop-up menus or lists 
of commands that appear when you right-click an item. Guard1 Plus also makes extensive use of "wizards", which act 
as guides and to automate various functions. By default, all wizards are enabled and appear automatically when 
needed. As you gain experience with Guard1 Plus you may want to turn off some of these wizards. 

.  

The right-hand pane of the Guard1 Plus main window is used to display the "properties" of numerous items. For 
example, with the Download  tab on top, you can position the mouse pointer over a download, select the download 
with the right mouse button, and a menu will pop up. If you select View  on that menu, the properties of that download 
will appear under a tab in the right pane of the Guard1 Plus window. You can have up to 10 properties tabs open at 
one time. 

Guard1 Plus includes a component called the Attendant. This loads automatically when Guard1 Plus starts, and 
unloads when you exit. The Attendant handles all communications between readers and your computer – it controls 
downloading patrol data. You’ll see the Attendant’s icon in the Windows task bar, near the clock display . The 
Attendant’s icon will change to show when a reader is present, when it’s being downloaded, etc. 

 

Database Import Wizard 

The Database Import Wizard should only be used when you want to import an existing GUARD1 PLUS database from 
release 2.xx. The Database Import Wizard will add the button and download data to the GUARD1 PLUS release 3.02 
master database. The Database Import Wizard should only be used once if you are upgrading to GUARD1 PLUS 3.02 
from an earlier GUARD1 PLUS release. If you run the Database Import Wizard more than once and import the same 
file then you are creating duplicate download and button data. To use the Database Import Wizard follow these steps: 

1 Click Start and point to Programs. 

2 Point to GUARD1 PLUS and click Database Import Wizard.  

3 Enter the filename of the version 2.xx database and click Next. 

4 To begin the import process, click Next. 
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5 After the import process is completed, click Finish to exit the Database Import Wizard. 
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Guard1 Plus Options 

Guard1 Plus has many options you can set to configure the program to your requirements. You can adjust how and 
when downloading occurs, set reminders for backing up or archiving patrol data, set passwords to limit access to the 
program’s functions, customize reports, and more. Some of the options are available only during the trial period or 
after you have activated the appropriate software module or modules. You can view and change most program options 
from a single Options  dialog box. 

There are several tabs across the top of the Options  dialog box. Select a tab to view or change options appropriate to 
the name on that tab. If you make changes to one or more options, save your changes by selecting Save. If you want 
to close the Options  dialog box without saving any changes, select Cancel. Select Help to view this help topic. 

 

General options 

There are several tabs across the top of the Options dialog box. Select a tab to view or change options appropriate to 
the name on that tab. The General tab allows you to set these options: 

  When the program starts, you will see a tip of the day. While these can be helpful or amusing, you may prefer to not 
see them. You can turn this option off, and you can turn it on again at any time. 

 

  If you set up remote devices you may wish to have these devices dial your computer to download their patrol data. 
Remote devices with this capability you must be given the number for the telephone line to which your computer’s 
modem is connected. 

  

Attendant options 

The Attendant has several options you can set to control the way downloading works. These options allow you to 
determine the level of download automation the Attendant provides. There are two places from which you can change 
the Attendant’s options: 

  From within the Guard1 Plus application, select the View  menu, then select Guard1 Plus Options. On the window 
that appears, select the Attendant  tab. 

  Right-click the Attendant’s icon  in Windows’ task bar, then select Options. Select the Options  tab. You can do this 
even if the Guard1 Plus program is not running. 

Either of these methods will display a window with options you can set. 

You can set up the Attendant to run at all times, even when Guard1 Plus is not running. You can set the Attendant to 
load when your computer is started so the Attendant is always available and devices can be downloaded anytime. If 
your devices support insert detection, anyone at any time, including during hours when the daytime staff is not 
available, can download by simply dropping a reader in a downloader. This person need know nothing about starting 
or using Guard1 Plus. The patrol data in that reader will be automatically downloaded. Any number of readers (and 
remote devices, too) can be downloaded. In the morning, or whenever Guard1 Plus is next started it will automatically 
process the download(s). You can also set an option that will cause Guard1 Plus to start automatically when a reader 
is detected. 

 Some options, such as insert detection, are available only with some of the supported devices. If your device does 
not support insert detection, you can start the download from the Attendant’s menu. .  

 

Launch Attendant when my computer starts 

The Attendant starts automatically when you start Guard1 Plus. You can set the Attendant to start automatically when 
your computer starts. This means the Attendant will always be available  to detect when you put a reader in your 
downloader, even if Guard1 Plus is not running. If the downloader supports insert detection, the reader will be 
automatically downloaded. 

 Some options, such as insert detection, are available only with some of the supported devices. If your device does 
not support insert detection, you can start the download from the Attendant’s menu. .  

To set this option: 

1 Select the View menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 On the Options  dialog box select the Attendant tab. 

3 Select the Launch Attendant when my computer starts  option to mark it. 

4 Select the Save  button to save the change and close the Options  dialog box. 

If you leave this option cleared, that is, no checkmark in the box, the Attendant will only run while Guard1 Plus is 
running. The Attendant will start when you start Guard1 Plus, and the Attendant will close when you exit Guard1 Plus. 
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 You can make the same changes from within the Attendant itself. To open the Attendant, right-click the Attendant's 
icon in Windows' task bar. Select Options  from the menu, then proceed as described above. When finished, select 
OK  to save the settings and close the window. 

 

Automatically start Guard1 Plus when a reader or button is detected 

You can set the Attendant to automatically start Guard1 Plus (if it isn’t already running) when you place a reader in 
your downloader or when you touch a button to the downloader's button port (applies to the Direct Downloader and 
Touch Memory buttons only). For this option to be effective, the Attendant must be running. The Attendant starts 
automatically when you start Guard1 Plus. You can also start the Attendant when needed, or you can set the 
Attendant to start when your computer starts. . 

If you enable this option you can have full automation of the downloading process. If your downloader supports insert 
detection the reader will be automatically downloaded when placed in the downloader. Guard1 Plus will automatically 
start and process the download. You can view the patrol data or print reports right away. 

 Some options, such as insert detection, are available only with some of the supported devices. If your device does 
not support insert detection, you can start the download from the Attendant’s menu. . However, the Automatically 
launch Guard1 Plus when a Reader or Button is detected  option only works for devices that support insert 
detection. Tell me more about detection method.  

To set this option: 

1 Select the View menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 On the Options  dialog box select the Attendant tab. 

3 Select the Automatically launch Guard1 Plus when a Reader or Button is detected  option to mark it. 

4 Select the Save  button to save the change and close the Options  dialog box. 

Now whenever you place a reader in your downloader, if the downloader supports insert detection it will be 
downloaded and Guard1 Plus will start. 

 If you have password protection enabled, you must enter a password before Guard1 Plus will start. 

If you leave this option cleared, that is, no checkmark in the box, the Attendant will not automatically start Guard1 Plus. 
This is the default setting. 

 You can make the same changes from within the Attendant itself. To open the Attendant, right-click the Attendant's 
icon in Windows' task bar. Select Options  from the menu, then proceed as described above. When finished, select 
OK  to save the settings and close the window. 

 

Download all devices when the Attendant starts 

You can set the Attendant so it will, when it starts, automatically search for all devices installed in the system. As each 
is found the Attendant will attempt to download the device's data. This applies to both locally connected and remote 
downloaders. 

The Attendant starts automatically when you start Guard1 Plus. You can also start the Attendant when needed, or you 
can set the Attendant to start when your computer starts. .  

To set this option: 

1 Select the View menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 On the Options  dialog box select the Attendant tab. 

3 Select the When the Attendant starts, automatically download all downloaders  option to mark it. 

4 Select the Save  button to save the change and close the Options  dialog box. 

Now whenever the Attendant starts (whether you start only the Attendant, it starts when you start Guard1 Plus, or it 
starts when you start your computer) any local devices found will be automatically downloaded. If you have added 
remote devices to your system, they will be dialed and their data downloaded. 

If you leave this option cleared, that is, no checkmark in the box, the Attendant will do nothing when it is started. This 
is the default setting. 

 You can make the same changes from within the Attendant itself. To open the Attendant, right-click the Attendant's 
icon in Windows' task bar. Select Options  from the menu, then proceed as described above. When finished, select 
OK  to save the settings and close the window. 
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Data Maintenance - overview 

As the amount of patrol data you collect and download increases, you will want to perform periodic "maintenance" on 
that data. Doing this can improve your system’s performance and provide a means of disaster recovery if you 
experience hard drive or computer failure. Data maintenance operations include: 

• Data Maintenance: This operation compacts the program’s data file and checks its integrity. These operations 
optimize its performance. You can think of this as a "tune up" for your patrol data file. Some types of internal errors 
can be corrected if this is done regularly, preventing problems with the data later. 

• Data Back Up and Restore: Computer hard drives can experience problems at any time. Power failures, hardware 
failures, vandalism, viruses, and other computer problems can damage data files beyond the ability of the Data 
Maintenance operation to repair. If you make regular back up copies of your data file, you can restore from the 
latest of these when disaster strikes. 

• Data Archiving: As your data file grows the performance of your system may slow. Deleting patrol data from your 
data file can help, but it may be necessary in your organization to keep patrol data going back several months or 
longer. You can periodically save an archive of your patrol data. This archive will contain all data downloaded prior 
to a date you specify. After the archive is made, the old data are removed from the Master data file, reducing its size 
and improving performance. You can view and print reports from the archive at any time. 

 For each of these operations you can set a reminder to appear periodically when the program starts. The Data 
Maintenance module performs these operations and includes a Wizard that simplifies setting them up. This module 
is active during the trial period, after which it will expire. To continue to benefit from the Data Maintenance module 
you must activate it. .  

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to restore from backups or archive 
data. You must have full access to perform these operations. Tell me about security and passwords.  

 

Performing data maintenance 

Data maintenance should be performed periodically to keep your patrol data file "healthy". This operation checks the 
integrity of your patrol data and can repair internal errors that may occur. It also compacts the data file, which you can 
think of as a "tune up" of the file. It is recommended that you perform data maintenance every 15 days. If you 
download hundreds of records a week, this should be done more often. This operation takes little time, and the 
program can give you a reminder at the proper time. 

To perform data maintenance: 

1 On the main window’s toolbar, select the icon for the Data Maintenance Wizard . If the toolbar is not visible, select 
the View menu, then select Toolbar. 

 This Wizard is part of the Data Maintenance module. This is active during the trial period, after which it will expire. 
To continue to benefit from the Data Maintenance module you must activate it. . 

2 On the first panel of the Data Maintenance Wizard select the Verify data integrity option. This is the default 
selection. 

3 Select Next. You will see the progress of the operation on the screen. 

4 When the operation is completed select Next. 

5 Select Finish to exit the Wizard. 

  You can schedule a reminder for this and other operations, including making backups of patrol data, archiving, etc. 

 

Backing up and restoring your patrol data 

A backup copy of your patrol data is good insurance, and is critical to restoring your data after a hard drive failure or 
other incident that damages your files. If your computer is damaged as the result of fire, flood, vandalism, etc., using a 
recent backup of your data is the only way to recover. Without it you must reenter all information about clients, 
facilities, groups, locations, officers, incidents, custom reports, etc. When disaster strikes you can restore your data 
from a recent backup, saving many hours reentering data. 

To make a backup: 

1 On the main window’s toolbar, select the icon for the Data Maintenance Wizard . If the toolbar is not visible, select 
the View menu, then select Toolbar. 

 This Wizard is part of the Data Maintenance module. This is active during the trial period, after which it will expire. 
To continue to benefit from the Data Maintenance Module you must activate it. . 

2 On the first panel of the Data Maintenance Wizard select the Back up my data  option. Select Next. 

3 If you know where you want the backup file stored, enter the full path and file name into the field. You can select 
Browse to find the folder you want to use and enter a name for the backup file. When you have the correct folder 
and file entered, select Next. 
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 The safest backup strategy is to save backup files to a separate disk drive, such as a removable (like Zip™ or other 
high-capacity disks) or a network drive. The selected drive must have sufficient free space to hold the backup data 
file. Note that floppy disks are impractical because your patrol data file will quickly become larger than the capacity 
of a floppy disk. 

4 The next panel will display the status of the backup operation. When the backup is completed select Next. 

5 Select Finish  to exit the Wizard. 

  You can schedule a reminder for this and other operations, including data maintenance, archiving, etc. 

  You can view the contents of a backup file. These are opened as "read only", meaning you can view and print from 
these backup files, but you can’t make any changes to the data they contain. 

To restore from a backup: 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to restore from backups. You 
must have full access to perform this operation. Tell me about security and passwords.  

1 On the main window’s toolbar, select the icon for the Data Maintenance Wizard . If the toolbar is not visible, select 
the View menu, then select Toolbar. 

 This Wizard is part of the Data Maintenance Module. This is active during the trial period, after which it will expire. 
To continue to benefit from the Data Maintenance Module you must activate it. 

2 On the first panel of the Data Maintenance Wizard select the Restore  my data from a backup  option. Select Next. 

 You must have full access security rights to the program in order to restore from a backup. If the Restore  my data 
from a backup  option is disabled ("grayed out"), you must exit and restart the program, and enter a password that 
gives you full access. 

3 Read the warning message. If you do not want to continue, select Cancel  to close the Wizard or Back  to return to 
the previous panel. If you want to continue, enter the full path and file name for the backup file you want to restore, 
or select Browse  to find the file. If you save your backup files to a removable disk, insert the disk, then select 
Browse  to locate the file. Select Next. 

 This operation will replace your existing data with the data from the backup. 

4 The next panel will display the status of the restore operation. When the restore is complete select Next. 

5 Select Finish  to exit the Wizard. 

Your patrol data, along with all clients, facilities, groups, locations, officers, incidents, custom reports, etc. are now 
restored up to the date on which you made the backup. You may have to edit some of these items to bring your 
system up to date. 

If the Data Maintenance module has expired you can still create backup files and restore from them, although the 
process is more complex. . 

 

How to back up and restore patrol data without the Data Maintenance Wizard 

The Data Maintenance Wizard makes it quick and easy to back up and restore the data you’ve entered and 
downloaded into Guard1 Plus. A recent backup of your data is critical to restoring the data after a hard drive failure or 
other incident that damages your files or computer. Typically, if making a backup is not fast and convenient, people 
won’t do it, leaving them with no means to restore their data when disaster strikes. The Data Maintenance Wizard 
makes this easy, so it is more likely to be done. 

 This Wizard is part of the Data Maintenance module. This is active during the trial period, after which it will expire. 
To continue to benefit from the Data Maintenance Module you must activate it. . 

If the Data Maintenance module has expired, it is still possible to make backup copies of your data and to restore 
from these when necessary, but it is more difficult to do this "manually". If you are unfamiliar with Windows Explorer, 
finding folders, and copying files, you should get help from an experienced computer user before proceeding. 

To manually back up your patrol data: 

1 If Guard1 Plus is running, exit the program. Select the close button on the program’s title bar or select the File 
menu, then select Exit. 

2 Start Windows Explorer. Open the folder in which Guard1 Plus was installed. The default path is C:\Program 
Files\Guard1 Plus, but it may have been installed in a different folder. 

3 In this folder, locate the file named G1Master.g1p. Copy this file. Do not move or delete the file. Do not move or 
delete any other files in this folder. Doing so may require a reinstallation of Guard1 Plus. 

4 Paste this file in another location. Ideally this should be pasted to a different drive – removable media (such as a Zip 
disk), a server volume, etc. Note that a floppy disk is not practical as this file quickly becomes too large for a floppy. 
Make a note of the location used, as this will be important should it become necessary to find this file later to restore 
your data. 

 You may wish to rename this file to include the backup date. This will allow you to keep multiple backup files in the 
same folder or at the root level of the same disk. 
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To manually restore your patrol data: 

1 If Guard1 Plus is running, exit the program. Select the close button on the program’s title bar or select the File 
menu, then select Exit. 

2 Start Windows Explorer. Open the folder in which the backup Guard1 Plus data file was stored. 

3 In this folder, locate the backup file and copy it. 

4 Open the folder in which Guard1 Plus was installed. The default path is C:\Program Files\Guard1 Plus, but it may 
have been installed in a different folder. If there is an existing data file in this folder, rename it. Then paste the 
copied file into this folder. 

5 If necessary, rename the file to G1Master.g1p. The master data file must be named G1Master.g1p or Guard1 Plus 
will not function properly. 

6 If you have replaced a damaged data file, start Guard1 Plus and verify that the program starts properly and the data 
are present. If you have replaced the hard drive or computer on which Guard1 Plus was originally installed, you 
must add your devices (readers and downloaders). Also, if you have installed Guard1 Plus on a new drive or 
computer, the program will start in Trial Mode. If you had previously activated the Basic System (and any additional 
software modules), you must obtain a new activation code and activate the software. 

Archive your patrol data 

Archiving your patrol data allows you to keep "old" data, but remove it from your master data file. This helps reduce the 
size of the master data, which improves system performance, makes reports print faster, and reduces the time needed 
to start Guard1 Plus and to make backups. 

When you archive your data, you enter a date, and all data prior to but not including that date, will be moved from your 
master data file to the archive. This removes that data from the master file. You can open the archive file to view and 
print reports from that data, but you will not be able to make any changes to data in an archive. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to archive your patrol data. You 
must have full access to make changes to the data. Tell me about security and passwords.  

To archive data: 

1 On the main window’s toolbar, select the icon for the Data Maintenance Wizard . If the toolbar is not visible, select 
the View menu, then select Toolbar. 

 This Wizard is part of the Data Maintenance Module. This is active during the trial period, after which it will expire. 
To continue to benefit from the Data Maintenance Module you must activate it. . 

2 On the first panel of the Data Maintenance Wizard select the Archive my data  option. Select Next. 

3 Read the warning on the next panel of the Wizard. If you do not want to continue, select Cancel to close the Wizard 
or Back to return to the previous panel. If you want to continue, enter a date and select Next. The default date is set 
to 60 days prior to today’s date, but you can enter any past date. 

 All data prior to, but not including, this date will be moved to the archive. 

4 If you know where you want the archive file stored, enter the full path and file name into the field. You can select 
Browse to find the folder you want to use and enter a name for the backup file. You should use a descriptive file 
name for this archive, perhaps including the date, so you can easily recognize the different archive files should you 
need them later. When you have the correct folder and file name entered, select Next. 

 Archive files may be stored on any drive, including your local hard drive(s), a removable (like Zip™ or other high-
capacity disks) or a network drive. The selected drive must have sufficient free space to hold the backup data file. 
Note that floppy disks are impractical because your patrol data file will quickly become larger than the capacity of a 
floppy disk. 

5 The next panel will display the status of the archive operation. When the archive is completed select Next. 

6 Select Finish to exit the Wizard. 

  You can schedule a reminder for this and other operations, including data maintenance, backing up patrol data, etc. 

  You can view the contents of an archive file. These are opened as "read only", meaning you can view and print from 
these archive files, but you can’t make any changes to the data they contain. 

 

View and print archive and backup files 

Once you have archived and/or backed up your patrol data, you can view or print reports from the archived or backup 
data files. 

To open an archive or backup file: 

1 Select the File menu, then select Open Archive… or Open Backup…. 

 This function is part of the Data Maintenance module. This is active during the trial period, after which it will expire 
and the menu choices will become disabled ("grayed out"). To continue to benefit from the Data Maintenance 
module you must activate it. .  
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2 Find and open the desired archive or backup file. 

3 Proceed to view the data or print reports from the archive or backup data as you would normally do with the master 
data. 

If you prefer, you can use the Data Maintenance Wizard to help open archive and backup files. 

To use the Data Maintenance Wizard: 

1 On the main window’s toolbar, select the icon for the Data Maintenance Wizard . If the toolbar is not visible, select 
the View menu, then select Toolbar. 

 This Wizard is part of the Data Maintenance module. This is active during the trial period, after which it will expire. 
To continue to benefit from the Data Maintenance module you must activate it. 

2 On the first panel of the Data Maintenance Wizard select the View data from a backup or archive  option. Select 
Next. 

3 Enter the full path and file name of the archive or backup file you want to open. You can select the Browse… button 
to locate the file if you don’t know its path or name. When you’ve found and selected the file you want, select Next. 

4 Select Finish. Proceed to view the data or print reports from the archive or backup data as you would normally do 
with the master data. 

 You will not be able to alter the data in the archive or backup. This means you cannot edit existing items such as 
clients, locations, etc., nor can you download into the archive or backup. 

When finished with the archive or backup data, return to the master data file by selecting the File menu, then select 
Use Master Data. 

 

Setting Data Maintenance reminders 

You can set reminders that will appear at intervals when the program starts. For each type of data maintenance 
operation you can set the number of days between the last time the operation was performed and the next reminder. 
This is an easy way to make sure your data file integrity is maintained, backups are made, etc. 

You can set reminders for three different data file operations: 

• Data maintenance, which compresses the master data file and checks its integrity 

• Data file backup, which will save a copy of your data file. The backup copy can be used to restore your data if the 
master file becomes damaged or lost. 

• Data file archive, which saves to an archive file all patrol data earlier than a date you specify, then deletes that data 
from the master file. 

 

 This function is part of the Data Maintenance module. This is active during the trial period, after which it will expire 
and the menu choices will become disabled ("grayed out"). To continue to benefit from the Data Maintenance 
module you must activate it. .  

To set reminder schedules: 

1 Select the View menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 On the Options  dialog box select the Data tab. 

3 To enable the reminder, select the Remind me every  box to mark it. 

4 Select the up or down arrows next to the days  field to increase or decrease the number of days, or select the field 
and type a number. 

5 Repeat this for each operation for which you want a reminder. 

6 Select Save  to save the changes you’ve made, or select Cancel  to close the dialog box without saving the 
changes. 

These interval for each can be unique. At any time you can repeat this from step 1 and change any of the settings. 

  If you wish to perform a data maintenance operation now, select the Data Maintenance button. This will start the 
Data Maintenance Wizard, which will help you with any of the operations listed above. 

Data Maintenance button 

Select the Data Maintenance button to start the Data Maintenance Wizard. This Wizard will help you with any of 
these maintenance operations: 

• Data maintenance, which compresses the data file and checks its integrity 

• Data file backup, which will save a copy of your data file. The backup copy can be used to restore your data if the 
master file becomes damaged or lost. 

• Data file archive, which saves to an archive file all patrol data earlier than a date you specify, then deletes that data 
from the master file. 
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  You can schedule reminders for these operations. The reminder(s) will appear when you start the program. 

  

Phone number for your computer 

If you have or plan to set up remote devices that will dial in to your computer, you can enter a default phone number 
for your computer’s modem. When you add each remote device to Guard1 Plus, this default phone number will be 
automatically entered for you. You can then edit the number as necessary for each remote location to include 
appropriate area codes, outside line numbers, etc. 

To enter the default phone number: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear with the General  tab 
in front. 

2 Select the My computer’s phone number  field and enter the number for the line connected to your computer’s 
modem. 

 You may want to include the area code or other long-distance dialing code if all of your remote sites require the 
same codes. You can edit these later when you add the devices to your system. 

3 Select Save  to save the number and close the dialog box. 

 

Show or hide Tip of the Day 

When the program starts it presents a Tip of the Day, which offers helpful information and tips about using the 
program. If you’d rather not see these tips you can turn off this option. If the Tip of the Day does not appear when 
Guard1 Plus starts, you can turn it back on. This may be useful when you have new officers who will be learning to 
use the program. 

To change the Tip of the Day option: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear with the General  tab 
in front. 

2 Selecting the Show Tip of the Day at application startup box to mark it . To turn off the Tip of the Day, select the 
box so that the check mark is removed. To turn on the tip, select the box so that the check mark appears. 

3 Select Save  to save your setting and close the dialog box. 

Security and passwords - overview 

You can limit access to Guard1 Plus or to specific functions of the program. When this is done, a password must be 
entered before the program will start. If an incorrect password is entered when starting the program, it will simply exit. 
You can use passwords to allow limited access so certain people can only print reports or only view information on-
screen. 

For example, you may wish several officers or others in your organization to have full access to all program functions. 
You could set up a password that would allow full access, then give this password to all of those individuals. You could 
also set up a unique password for each person, still allowing full access. You may wish to allow other individuals to 
print reports, but have no other access. They could not download readers, add buttons, clients, facilities, delete data, 
etc. You could give those individuals a shared or individual password that would allow only this limited access. 

 Setting up security and passwords is optional. If there is no need in your organization to protect the data in Guard1 
Plus, or to protect individuals from altering or deleting data in the program, it may not be necessary for you to set up 
passwords. 

You can set three levels of access: 

• Full, which allows someone with the correct password to use all program functions. Full access is required to add, 
edit or delete passwords. Only the Supervisor can turn password protection on or off. 

• Read-only, which allows someone with the correct password to view everything in the program and print reports, 
but they cannot perform any other operations or save any changes. 

• Reports only, which allows someone with the correct password to print reports, but they cannot perform any other 
operations or save any changes. 

Anyone with no password will be unable to start the program.  

Before setting up passwords for these levels of access, a Supervisor password must be set. Supervisor access is 
required by at least one person, and only with Supervisor access can other passwords be added, changed, or deleted. 
Once passwords are assigned they can be reviewed or edited by the Supervisor by selecting from a list. 

Setting up passwords also allows you to determine whether reports can be saved as separate files and/or emailed. 
This feature is enabled by default; if you don’t set up passwords, reports that use any style except "dot matrix" can be 
saved as Microsoft Word documents. This allows you to save specific reports for later review or printing, and it also 
allows you to send reports via email. To disable this feature, you must set up a Supervisor password. Note that saving 
or emailing of reports requires the Rules and Advanced Reporting module. Tell me more about saving and emailing 
reports.  
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 Anyone, whether they have a password or not, and regardless of their level of access, can download patrol data 
into Guard1 Plus. 

  

Turning on or off password protection 

Before you can set up passwords for the program’s users, you must enable, or turn on, password protection. Once 
you’ve done this, you can turn it off at any time. This allows you to experiment to determine if this type of security is 
necessary for your organization, or to turn it on at a later time if your methods of operation change. 

To use password protection, at least one user must have the Supervisor password. This is the highest level of 
security. When someone starts the program with the Supervisor password they have full access to all program 
features and functions, including the ability to assign passwords to others and to turn password protection on or off. 

To enable password protection: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Security  tab on the Options  dialog box. 

3 By default, the Use Password Protection  box is not checked. Select this option to mark it . 

4 Select the Supervisor Password  field and type a password. You will see * characters in the field so the actual 
password can’t be seen by anyone. 

 Passwords can contain letters, numbers, or both and are case sensitive. Passwords may be up to 14 characters 
long. You should choose a password that is easy to remember but difficult for anyone to guess. It is not good 
practice to use birth dates, names of spouses or pets, and other commonly available information as passwords. 

5 Select the Confirmation  field and type the same password again. This helps to verify there were no typing mistakes 
in the first field. 

 If you enable password protection, you also gain control over emailing and saving of reports. When password 
protection is disabled, your system is not secure. By default, when password protection is disabled, the Users can 
e-mail and save reports box is checked  and can’t be changed. When you enable password protection, you can 
change this setting. Tell me more about saving and emailing reports.  

6 Select Save. 

 DO NOT forget the Supervisor password. If this password is lost or forgotten you will not be able to start the program 
and have full access to its features, including adding or changing passwords. 

 

To turn off password protection: 

 You must have Supervisor access to change this setting. 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Security  tab on the Options  dialog box. 

3  Select the Use Password Protection  box to remove its check mark. 

4 Select Save. 

 If you turn off password protection, the Users can e-mail and save reports checkbox will automatically be checked, 
enabling this option. Tell me more about saving and emailing reports.  

 

Adding and changing passwords 

You can add as many passwords as necessary. You may wish to have only a few passwords which are shared among 
the program’s users, or you may want to have a unique password for each user. You can give each user specific 
access rights if desired. 

You can also change passwords or change the access rights for a particular password. 

 You must have Supervisor access to add or edit passwords. .  

To add a new password: 

1 Start Guard1 Plus using the Supervisor log-in and password. .  

2 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

3 Select the Security  tab on the Options  dialog box. 

4 Select the Add  button. The Add User  dialog box will appear. 

 If the Add  button is disabled ("grayed out"), you either don’t have Supervisor access or the Supervisor Password  
and Confirmation Password  don’t match. 

5 Type a name for the user in the Name  field. 

6 Type a password in the Password  field, then type it again in the Confirmation Password  field. 
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7 Leave the check mark in the User can use Guard1 Plus box . 

 You can select the box to remove the check mark if you want to temporarily disallow this user access to the 
program. Check the box later to reinstate this user. 

8 Select the down-arrow next to the Access Rights  field and select the desired access from the list. 

9 Select Save  to save your changes close the dialog box. In the Options  dialog box you will see this user added to 
the list. If you decide to discard the changes you’ve made, select Cancel  instead of Save. 

The users and passwords you add to the program appear in a list on the Options  dialog box. You can sort this list by 
selecting a column heading. If your list is long, you can sort by user name by selecting the Name  heading. This makes 
it easy to find a particular user in a long list. 

To edit the user name, password, or access rights for a user: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Security  tab on the Options  dialog box. 

3 Select a name to edit from the list. If your list is long, you can select a column heading to sort by that column. This 
will make finding a specific user name, for example, much easier. 

4 Select the Edit  button. The Edit <user name>  dialog box will appear. 

5 Proceed as described in steps 4 through 8 as necessary in the section above. 

 

Turning on or off emailing and saving reports 

Guard1 Plus can save reports as Microsoft Word documents. Reports can also be sent via email, either from within 
Word or from your email program. This feature can be turned off if desired. The control for this is on the Security tab of 
the Guard1 Plus Options window. 

 This option is available only during the trial period or after the Rules and Advanced Reports module is activated. 
Otherwise it is disabled ("grayed out"). Also, you must have Microsoft Word 97 or later installed on your computer in 
order to print reports with these options and styles. 

 Guard1 Plus does not include email "client" software. To send email, you must have appropriate software installed 
and access to the Internet, either through an internal network or via a dial-up or other type of connection. 

Setting up passwords allows you to determine whether reports can be saved as separate files and/or emailed. This 
feature is enabled by default; if you don’t set up passwords, reports that use any style except "dot matrix" can be 
saved as Microsoft Word documents. This allows you to save specific reports for later review or printing, and it also 
allows you to send reports via email. To disable this feature, you must set up a Supervisor password. 

To turn off emailing and saving of reports: 

 You must have Supervisor access to change this setting. 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Security  tab on the Options  dialog box. 

3 By default, the Users can e-mail and save reports  box is checked . 

  If you want to turn this feature off, select the box to remove its check mark. 

  If you want to turn this feature on, select the box to mark it . 

If the check box is marked but disabled ("grayed out"), you have not turned on password protection. You must do 
this before you can change the Users can e-mail and save reports  box. .  

If the check box is not marked and disabled, the Rules and Advanced Reporting module has expired. You must 
activate this module before you can use the emailing and saving option. .  

4 Select Save. 

 If you turn off password protection, the Users can e-mail and save reports checkbox will automatically be checked, 
enabling this option. 

Tell me more about saving and emailing reports.  

 

Starting the program after password protection is enabled 

After a password has been set up you must enter a password each time you start the program. 

To start the program after passwords have been enabled: 

1 If the program is running, select the File  menu, then select Exit. 

2 Restart the program. The Login  dialog box will appear. 

3 Select the down-arrow next to the User  field, then select the user name from the list. 

 To add, change, or delete passwords or users, you must select Supervisor from this list. 
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4 Select the Password  field and type the password. You will see only * characters as you type. 

5 Select OK. The program will start. If the user name and password you used allows read-only access, you will notice 
that some program functions are disabled ("grayed out"). You will not be able to save changes to anything in 
Guard1 Plus. If the user name and password allows reports only access, you will see Reports tab in the left pane of 
the main window. Other tabs will be unavailable. You may have to exit and log in with a different password if you 
require full or Supervisor access. 

If you don’t know the password or if you decide not to start the program, select the Cancel  button to close the Login  
dialog box. The program will not start. 

If you make a mistake entering the password, you can try again. After three incorrect login attempts the program exits. 
Start again with step 2 above. 

 

Enable or disable Wizards 

Guard1 Plus makes use of software Wizards – helpers that make performing various tasks easy. These Wizards 
typically appear when needed and walk you through a process one step at a time. A few Wizards are always available, 
but most can be turned off (disabled) or turned on again (enabled) as needed. 

Wizards are available to help you add devices (readers and downloaders) to your system, add new buttons   and   
activate program modules. There are also Wizards to help with adding clients, facilities, and groups, and perform data 
maintenance and backup operations. 

After you have worked with the program for a while and become familiar with many of its functions, you may find that 
you no longer need some of the Wizards, and that you’d prefer to perform a given task "manually". In these cases you 
can disable the associated Wizard. Later, if you need to train a new user, for example, you may wish to re-enable one 
or more Wizards. By default all Wizards are enabled. 

To disable a Wizard: 

1 Use the Wizard as you normally would. The last panel of every Wizard has a Finish  button. 

2 When you get to the Finish panel select the Don’t show me this anymore  option to mark it . 

 If the last panel of the Wizard does not have a Don’t show me this anymore  box, that Wizard cannot be disabled. 

3 Finish the Wizard as you normally would, usually by selecting the Finish  button. 

That Wizard will not appear in the future, but you can re-enable it by following the steps below. 

To re-enable Wizards: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Wizards  tab on the Options  dialog box. 

3 Any wizard disabled by following the steps above will appear in the list on the Wizards  tab. If the box next to the 
Wizard name is empty that Wizard is disabled. Select the box to mark it  and re-enable that Wizard. If you want to 
enable all Wizards, select the Select All  button. 

 If there is already a check mark in the box next to the Wizard name, that Wizard is enabled. You can disable it by 
selecting the box to remove the check mark. To disable all Wizards, select the Deselect All  button. 

4 Select Save  to save your changes and close the Options  dialog box. If you want to close the dialog box without 
saving any changes, select Cancel. 

Though technically not a Wizard, all of the above procedures also work for the Welcome Screen.  

 

Setting "global" defaults for reports 

When you create custom reports, there are a number of settings you can make that control the data included on the 
report and the report’s appearance. These settings include: 

• the date range for the patrol data to be included (required for some types of reports),  

• the first day of the week, 

• whether to include your company's logo on reports,  

• whether to include a watermark (a background image that appears behind the printed data),  

• whether to include detailed headings, which includes full contact information about the client or facility for whom the 
report is being printed, 

• whether to include statistics, (for rule-based reports only), which display the number of rules, time periods, and time 
periods with exceptions processed, and the number of exceptions, 

• your choice of report "styles" from a list that includes dot matrix, business, classic, contemporary, professional, 
and simple. 
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If you usually want the same options each time you create a new custom report, you can set all of these options as 
desired and save them as the default settings. Your new settings will be used for each new custom report. You will still 
have the option to change any of these settings for a specific report. 

 

Setting the default date range for reports 

When printing reports it is usually necessary to specify a range of dates, and patrol data collected between those 
dates will be included in the reports. You can specify a date range each time a report is printed, but you can often save 
a few steps by setting a default date range for all reports. Your settings will be the new defaults and will be used when 
you create new custom reports. You will still have the option to change the date range for specific reports when you 
save them. 

 Most of these options are available during the trial period or after the Rules and Advanced Reports module is 
activated. Otherwise they are disabled ("grayed out"). 

To set a default date range: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Reports  tab on the Options  dialog box. You will see the current default date range in the Example  
frame. 

3 Select the Change  button. The Date Range  dialog box will appear. 

4 Make the desired changes: 

• Select the Past  option if you want to include a time period that ends with yesterday’s date. You can include today’s 
date in that range by selecting the Include Today  option to mark it. 

• Select the Last  option if you want to set a range that ends with the last day of the selected period (day, week, or 
month). 

• Select the up or down arrow next to the number field to increment or decrement the value. You can also type a 
number directly into this field if desired. 

• Select the desired time interval: Days, Weeks, or Months. 

5 The dialog box will display the date range your settings have created and an example of that range. Select OK  to 
apply these settings or Cancel  to discard them. The Date Range  dialog box will close. 

6 Select the Save  button to close the Options  dialog box. 

 

Setting the default print options for reports 

You can set several "global" options that determine the appearance of printed reports. You can choose to include 
company logos, watermarks, detailed headings, and patrol statistics on reports. You can also select various templates 
that determine the report style. You can specify appearance options each time a report is printed, but you can often 
save a few steps by setting default options for all reports. Your settings will be the new defaults and will be used when 
you create new custom reports. You will still have the option to change report options for specific reports when you 
save them. 

 These options are available during the trial period or after the Rules and Advanced Reports module is activated. 
Otherwise they are disabled ("grayed out"). Also, you must have Microsoft Word 97 or later installed on your 
computer in order to print reports with these options and styles. 

To set appearance options: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Reports  tab on the Options  dialog box. 

3 Select the desired options from the boxes in the Options and from the Date Range  frame. You can select any 
combination of these options. 

4 The Style  frame shows a thumbnail image of the report template currently selected. To change this, select the 
down-arrow next to field under the thumbnail image, then select a template from the list. The thumbnail will change 
to reflect your choice. 

5  Select Save  to save these settings or Cancel  to discard them. The Options  dialog box will close. 

 

Setting the default "Presented By" information for reports 

The Rules and Advanced Reports module allows you to include customized cover sheets on reports. The cover 
sheets include a section for "Presented By" information. This is typically your company, with a contact name, address, 
and phone, fax, and email information. If you produce patrol reports on behalf of other customers or clients, the 
"Presented By" information could be from one of those. The information you enter as the "global" default cover sheet 
will be applied to all new cover sheets you create. If you present reports on behalf of several clients or customers, you 
can edit this information when reports are created. 
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This information is optional. If you do not use the Rules and Advanced Reports module, or if you don’t want this 
information on cover sheets for your reports, you can leave these fields empty. 

 While you can enter this information at any time, cover sheet printing is available only during the trial period or after 
the Rules and Advanced Reports module is activated. Also, you must have Microsoft Word 97 or later installed on 
your computer in order to print cover sheets. 

To set the "Presented By" information: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Presented By  tab on the Options  dialog box. 

3 Enter appropriate information into the fields provided. You can leave some of the fields empty if desired. 

4  Select Save  to save these settings or Cancel  to discard them. The Options  dialog box will close. 

Activating software modules  
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Setting Keypad Module options 

The Keypad Module in Guard1 Plus allows you to create numeric button keypads for use with THE PIPE. A Keypad is 
a set of 12 touch memory buttons, representing the numbers 0 through 9, plus Enter and Cancel keys. Patrol officers 
carry the buttons for each keypad in small wallets, attached to clipboards, etc. The officer can then enter locations, 
such as room numbers, as well as incidents and officers by reading a series of buttons on the keypad. 

This provides the same functionality as readers that have fragile data-entry keypads, but in the much more durable 
form of THE PIPE and touch buttons. 

 Keypad functionality is available during the trial period or after the Keypad Module is activated. Otherwise, the 
Keypads tab and features are not available. Tell me about activating modules.  

Each button "type" is defined by a unique number of digits, or button reads, followed by the Enter button. By default, 
Guard1 Plus defines locations as having four digits, incidents three, and officers two. Each "type" has a definition that 
identifies them in reports, etc. See the Keypads tab overview for details. You can change these settings to suit the 
needs of your organization. 

When you create the first keypad, the Keypad Module Setup Wizard will start automatically to help you set up 
definitions for custom buttons used in keypads. Once you’ve made your settings, the Wizard will not run automatically 
again. However, you can run this Wizard from the Keypads tab on the Guard1 Plus Options screen if you want to alter 
these settings later. You can also "turn off" the Keypad Module, which will remove the Keypads tab from the Guard1 
Plus main window. 

 

To view or change Keypad Module settings: 

1 Select the View  menu, then select Guard1 Plus Options. The Options  dialog box will appear. 

2 Select the Keypads  tab on the Options  dialog box. The Example section of the tab will show you the current 
Keypad Module settings. 

3 If the contents of the Keypads tab are disabled ("grayed out"), either the Launch the Keypad Module when Guard1 
Plus starts box is not checked, or the Keypad Module has expired. During the trial period, or after the module has 
been activated, you can control whether it loads when Guard1 Plus is started. Select the box to mark it  if you want 
to have access to keypads. Uncheck the box to turn the Keypad Module off. 

 If you change this setting and select the Save button, the change will not take place until you exit Guard1 Plus and 
restart it. 

4 If you would like a Wizard to help change these settings to best suit the needs of your organization, select the 
Keypad Module Setup Wizard button. Follow the Wizard’s instructions. You can get help within the Wizard by 
selecting the Help button on any of its panels. 

5 You can "manually" change any of the settings: 

  Select the Location, Incident, and Officer boxes to mark  them if you want to use the button type in your keypads. If 
you want to exclude a type, select the box for that type to unmark it. If, for example, your organization does not wish 
to use keypad officer buttons, select the Officer box uncheck it. 

  Use the up and down arrows to change the number of digits for each type of keypad button. Note that each type 
must have a unique number of digits. You cannot use the same number of digits for more than one type. 

  Enter a description for each type of button in your keypads in the begins with box. These can be any text, numbers, 
or punctuation, up to 255 characters each. 

6 The example will show you the result of your changes as you make them. When you’ve made the necessary 
changes, select the Save button to save the changes and close the Options window. 

You can return to the Keypads tab at any time and change the settings. 

 

Launch the Keypad Module when starting option 

The Keypad Module in Guard1 Plus allows you to create numeric button keypads for use with THE PIPE. A Keypad is 
a set of 12 touch memory buttons, representing the numbers 0 through 9, plus Enter and Cancel keys. Patrol officers 
carry the buttons for each keypad in small wallets, attached to clipboards, etc. The officer can then enter locations, 
such as room numbers, as well as incidents and officers by reading a series of buttons on the keypad. 

This provides the same functionality as readers that have fragile data-entry keypads, but in the much more durable 
form of THE PIPE and touch buttons. 

 Keypad functionality is available during the trial period or after the Keypad Module is activated. Otherwise, the 
Keypads tab and features are not available. Tell me about activating modules.  

You can turn off (disable) or on (enable) the Keypad Module as needed. If you disable keypads, the Keypads tab and 
menu will be removed from the Guard1 Plus main window. You can enable keypads later, and all settings made earlier 
remain in place. 
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During the trial period, or after the module has been activated, you can control whether it loads when Guard1 Plus is 
started. Select the Launch the Keypad Module when Guard1 Plus starts box to mark it  if you want to use keypads. 
Uncheck the box to disable the Keypad Module. 

 

Location, Incident, Officer checkboxes 

The Keypad Module in Guard1 Plus allows you to create numeric button keypads for use with THE PIPE. A Keypad is 
a set of 12 touch memory buttons, representing the numbers 0 through 9, plus Enter and Cancel keys. Patrol officers 
carry the buttons for each keypad in small wallets, attached to clipboards, etc. The officer can then enter locations, 
such as room numbers, as well as incidents and officers by reading a series of buttons on the keypad. 

This provides the same functionality as readers that have fragile data-entry keypads, but in the much more durable 
form of THE PIPE and touch buttons. 

 Keypad functionality is available during the trial period or after the Keypad Module is activated. Otherwise, the 
Keypads tab and features are not available. Tell me about activating modules.  

Select the Location, Incident, and Officer boxes to mark  them if you want to use the button type in your keypads. If 
you want to exclude a type, select the box for that type to unmark it. If, for example, your organization does not wish to 
use keypad officer buttons, select the Officer box uncheck it. 

If these checkboxes are disabled ("grayed out"), make sure the Launch the Keypad Module when Guard1 Plus starts 
box is checked . If the checkbox is disabled, the Keypad Module has expired. You must activate the module before 
you can set up keypads. 

  

Location, Incident, Officer number (of digits) 

The Keypad Module in Guard1 Plus allows you to create numeric button keypads for use with THE PIPE. A Keypad is 
a set of 12 touch memory buttons, representing the numbers 0 through 9, plus Enter and Cancel keys. Patrol officers 
carry the buttons for each keypad in small wallets, attached to clipboards, etc. The officer can then enter locations, 
such as room numbers, as well as incidents and officers by reading a series of buttons on the keypad. 

This provides the same functionality as readers that have fragile data-entry keypads, but in the much more durable 
form of THE PIPE and touch buttons. 

 Keypad functionality is available during the trial period or after the Keypad Module is activated. Otherwise, the 
Keypads tab and features are not available. Tell me about activating modules.  

Use the up and down arrows to change the number of digits for each type of keypad button. Note that each type must 
have a unique number of digits. You cannot use the same number of digits for more than one type. 

If these fields are disabled ("grayed out"), make sure the Launch the Keypad Module when Guard1 Plus starts box is 
checked . If the checkbox is disabled, the Keypad Module has expired. You must activate the module before you can 
set up keypads. 

  

"Begins with" fields 

The Keypad Module in Guard1 Plus allows you to create numeric button keypads for use with THE PIPE. A Keypad is 
a set of 12 touch memory buttons, representing the numbers 0 through 9, plus Enter and Cancel keys. Patrol officers 
carry the buttons for each keypad in small wallets, attached to clipboards, etc. The officer can then enter locations, 
such as room numbers, as well as incidents and officers by reading a series of buttons on the keypad. 

This provides the same functionality as readers that have fragile data-entry keypads, but in the much more durable 
form of THE PIPE and touch buttons. 

 Keypad functionality is available during the trial period or after the Keypad Module is activated. Otherwise, the 
Keypads tab and features are not available. Tell me about activating modules.  

Enter a description for each type of button in your keypads in the begins with box. These can be any text, numbers, or 
punctuation, up to 255 characters each. These descriptions will precede the custom button numbers reports. For 
example, if you define keypad locations to require four digits, and set the begins with field to "Room #", and buttons 
"1", "9", "5", and "3" were read from a keypad, this would appear in reports as a single custom button, named "Room # 
1953". 

If these fields are disabled ("grayed out"), make sure the Launch the Keypad Module when Guard1 Plus starts box is 
checked . If the checkbox is disabled, the Keypad Module has expired. You must activate the module before you can 
set up keypads. 

  

Keypad Module Setup Wizard button 

The Keypad Module in Guard1 Plus allows you to create numeric button keypads for use with THE PIPE. A Keypad is 
a set of 12 touch memory buttons, representing the numbers 0 through 9, plus Enter and Cancel keys. Patrol officers 
carry the buttons for each keypad in small wallets, attached to clipboards, etc. The officer can then enter locations, 
such as room numbers, as well as incidents and officers by reading a series of buttons on the keypad. 
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This provides the same functionality as readers that have fragile data-entry keypads, but in the much more durable 
form of THE PIPE and touch buttons. 

 Keypad functionality is available during the trial period or after the Keypad Module is activated. Otherwise, the 
Keypads tab and features are not available. Tell me about activating modules.  

If you would like the Keypad Module Setup Wizard to help change the settings on this tab to best suit the needs of 
your organization, select the Keypad Module Setup Wizard button. Follow the Wizard’s instructions. You can get help 
within the Wizard by selecting the Help button on any of its panels. 

If the button is disabled ("grayed out"), make sure the Launch the Keypad Module when Guard1 Plus starts box is 
checked . If the checkbox is disabled, the Keypad Module has expired. You must activate the module before you can 
set up keypads. 
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Starting Guard1 Plus - the Welcome screen 

When you start Guard1 Plus you will see a Welcome  screen. There is a lot of information presented there, and some 
of it changes depending on the "state" or mode of the program. 

Guard1 Plus has three modes in which it can start: 

• Trial mode: Guard1 Plus is designed to allow you to use all of its features and functions, including all available 
software modules, for a trial period. This trial period begins the first time you run Guard1 Plus. If you are using the 
program in its trial mode, the Welcome  screen will indicate this and will also tell you the number of days remaining 
in the trial period. You can activate the Basic System and any software modules during the trial period if desired. 

• Expired mode: If you do not activate the Basic System or any software modules before the trial period ends, the 
system will "expire". If you start the program after expiration, the Welcome  screen will indicate this by displaying a 
list of expired modules. If the Basic System is in the list, you will not be able to start the program. The Start  button 
will be disabled ("grayed out"). You must activate the Basic System to continue to use the program. 

• Registered mode: After you activate the Basic System, and optionally any software modules, the Welcome  
screen will display Registered Status. If you have not activated all available modules it will display a list of those that 
have expired. The Welcome  screen will also have a Don’t show me this message anymore  box. Select this option 
to mark it  if you don’t want to see the Welcome  screen again when you start the program. You can enable this 
Welcome screen later if you wish. . 

  Select the Start  button to start Guard1 Plus. If the Start  button is disabled, you must activate the Basic System to 
continue to use the program. 

  Select the Activate  button to start the Activate Software Wizard. This Wizard will help with the software activation 
process. The Basic System can be activated at no charge – this is free software. Activation of additional software 
modules must be purchased. The Wizard will provide instructions for module activation. 

 Select the Help  button to display this on-line help information. 

  If you wish to close the Welcome  screen and exit Guard1 Plus, select Cancel. 

Working with sample patrol data 

 Even if you don’t normally read manuals or on-line help for software, reviewing this section will help you get started 
with Guard1 Plus. Once you’ve reviewed this section and used the software for a while, you can come back to the 
on-line help when you want to learn more. 

Guard1 Plus includes an extensive "sample" patrol data file. Exploring the sample data is a good way to get familiar 
with the program’s features and functions and to learn your way around the program. The tutorial will give you some 
hands-on experience with "getting around" in Guard1 Plus. It includes links you can select to display more detailed 
Help topics. 

Start Guard1 Plus by double-clicking its icon on the Windows desktop. When the Welcome screen appears select 
Start Guard1 Plus. 

 If the Start Guard1 Plus button is disabled ("grayed out"), the trial period has elapsed and the Basic System has 
expired. You must activate the Basic System to continue to use Guard1 Plus. Tell me about activating modules.  

With the sample data you can view patrol data, print reports, add and delete clients, facilities, groups, locations, 
officers, incidents, and much more. If you have guard tour devices you can install these and download non-essential 
data to learn how that process works. 

To load the sample data: 

1 Select the File  menu, then select Use Sample Data. The sample data file will be loaded. 

 The first time the sample is loaded, Guard1 Plus will build the data file. Because the file is large, this will take from 
five to 20 minutes, depending on the speed of your computer. The sample data will load much more quickly the next 
time you use it. When complete, the status bar will indicate that the sample data is loaded. 

2 Proceed to view the data or print reports from the sample data as you would normally do with the Master data. 

3 If you download a reader into the sample data, the Download Into Sample Data Wizard will start. 

4 When you have completed the tutorial, return to the Master data file by selecting the File menu, then select Use 
Master Data. 

I'm ready to view the tutorial.  

Tutorial, part 1 - Getting started 

This tutorial will give you some hands-on experience with "getting around" in Guard1 Plus. It includes links you can 
select to display more detailed Help topics. As you work through the tutorial, you can select any terms with a dotted 
underline to see the definition of that term or to "pop-up" more help. Select words or phrases with a solid underline to 
jump to their help topics. This section assumes you have loaded the sample data and are ready to proceed with the 
Guard1 Plus tutorial. This section also assumes you have full access to Guard1 Plus. If you have read-only or reports-
only access to the program, you will not be able to make changes to the data. 

Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 
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The sample data file was created for North Shore Security, Inc., a fictional security company that serves two clients. 
One of these clients has multiple facilities. To see what this setup looks like, select the Facilities  tab. In the Facilities 
treeview, under the Clients  node you’ll see the clients. Expand the GEM Manufacturing node and then the Building 
Tour group to view the locations assigned to it. . You can scroll through the list to view all the locations assigned to 
that client. For details (called "properties" in Guard1 Plus) about the client, right-click the Client  icon  next to GEM 
Manufacturing. From the menu that appears select Edit. A properties tab will appear for that client. Note the client’s 
name on the new tab, the fields available for entering information about the client, and the toolbar buttons across the 
top of the properties tab. Tell me more about how Guard1 Plus is organized. For more information about the fields and 
buttons on any properties tab, select the Quick Help  icon button on the tab’s toolbar. 

To view details about one of GEM’s locations, right-click the location button icon  next to Cafeteria, then select Edit. 
You can also simply double-click the Cafeteria button icon. A properties tab for that location will appear on top of the 
properties tab that was previously displayed for the client. If you select the GEM Manufacturing properties tab it will 
come to the top. You can have a maximum of 10 properties tabs open at one time. Open tabs for several more of 
GEM’s  locations. On the properties tab for a location, enter some additional text into the Notes  field. Notice that the 
Save  icon  on the tab’s toolbar is no longer dimmed. Select this to save the changes you made to the tab. Select 
some of the other tabs to see how each comes to the top when selected. 

To close properties tabs, select the Close  icon  on the tab’s toolbar (far right). If you have several tabs open you can 
save a step by right-clicking any properties tab, then selecting your choice of options to close all tabs, close the active 
(top) tab, or close all but the active tab. Close all tabs, then select the minus icon  next to GEM Manufacturing to 
collapse that node (or just double-click the client’s icon). 

 The Help tab is not controlled by these menu items. By default, the Help tab is always available. If you want to 
close the Help tab, select the Help Tab icon  button on the main toolbar. To show the Help tab, select this button 
again. 

To view a more complex client, expand the Metropolitan Clinic. client. You’ll see that this client has three facilities. 
Expand Main Campus. Under this facility you’ll see a number of groups. Expand the Health Services Building group 
node to see the locations there. You can view the properties of the facility and group by right-clicking the icons and 
selecting Edit. You can make changes to these items as before, and save them by selecting the Save  icon  on the 
properties tab’s toolbar. 

On the Health Services Building group’s properties tab, note the two Member of:  buttons. Select the button labeled 
Metropolitan Clinic. This will display the properties tab for that "parent" client. Select the Health Services Building  
group’s properties tab, then select the Main Campus  button. This will display the properties tab for that facility. Close 
all tabs by right-clicking a properties tab, then select Close All Tabs. You can also select the Tabs menu, then select 
Close All Tabs, or press F2 to close all tabs. 

You can have facilities and groups that are not part of a client. This is useful for in-house security organizations that do 
not service clients. You’ll notice that the clients/facilities/groups treeview is a hierarchical structure and is very flexible. 
You can have clients that have facilities, facilities and groups, groups only, or locations only. A client’s facilities can 
have groups under them. Tell me more about clients, facilities, and groups.  

Scroll down under the Facilities  tab and you’ll find a number of location buttons under the Unassociated Locations  
node. These are locations that were added to the system, but have not been added to any client, facility, or group. 
These are unassociated locations. 

Right-click the Groups  icon  then select New Group. The New Group Wizard will appear. Enter a name into the Group 
Name field, then select Next. On the next panel, select Finish. For help with the Wizard’s panels, select the Help 
button on each panel. Your new group will appear under the Groups  node. Right-click this new group and select Edit. 
You can enter a note about the group here and click the Save  icon button to save it. Select the Add a Location  icon 
button  at the top of the group’s tab. The Add Locations Wizard will appear. Next to each available location you’ll see a 
box. If you select this box a check mark  will appear. Select to mark boxes for several locations. Select  Next , then 
select Finish. For help with the Wizard’s panels, select the Help button on each panel. You will see the added 
locations appear under the new group. These locations have been removed from the Unassociated Locations  node. 
You add locations to clients or facilities in the same way. Tell me more about adding locations to clients, facilities, and 
groups.  

Select the Buttons  tab. As you expand the nodes for the different types of buttons and scroll down through the list, 
you’ll see all of the buttons in the sample data. There is a node for each of the four button types. Right-click the 
Locations  node and select View All Location Buttons. A properties tab will appear, and the number of buttons shown 
will appear in the status bar. You can select and drag the divider between the column headings to make a column 
wider so you can see the complete location name. Right-click any location in the list and select Edit  to see a 
properties tab for that location. As a shortcut, you can simply double-click a location and a properties tab will appear. 
Select the Location Buttons  tab to bring it to the top. If your computer has a printer attached, select the Print  icon  on 
the properties tab’s toolbar. This will print a complete list of the location buttons in the sample data. Note that in the 
sample data this is a very long list. Everything you’ve done above with location buttons can also be done with incident, 
officer, and unassigned buttons. 

You can add new buttons to Guard1 Plus. There are two methods for doing this, and the one you will use is 
determined by the type of buttons you are adding (Touch Memory buttons, Morse stations, Detex/GCS strips, or 
Deister checkpoints) and whether they are already installed at the patrol stops in the field. Tell me about adding 
buttons.  
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You can add up to three photos for each location button. Tell me more about using photos with locations. You can see 
what this looks like by opening a properties tab for locations under the Metropolitan Clinic client. On a location 
properties tab, select the Photo 1 sub-tab to view the photo. Note that only locations can have photos. These are 
generally used to help officers learn the locations of the buttons. 

After your buttons have been added to Guard1 Plus, you can add them to clients, facilities, or groups as required. If 
your organization does not make use of clients, you can still add buttons to facilities or groups, or use the buttons as 
unassociated locations without adding any clients, facilities, or groups. 

Under the Buttons  tab, scroll down to the Incident Buttons node. Notice that there are several buttons with duplicate 
names. This allows creating several sets of incident buttons for officers to carry on their tours. Right-click the Incident 
Buttons  node and select View All Incident Buttons. This will produce a properties tab similar to the one seen for 
location buttons. You can print this list in the same way, or you can right-click the Incident Buttons node and select 
Print Incident Listing from the menu that appears. 

Under the Buttons  tab, scroll down to the Officer Buttons  node and expand the node if necessary. Right-click the 
Officer Buttons  node and select View All Officer Buttons. On the new properties tab, right-click any officer button and 
select Delete. Select Yes  in the warning to delete that button from the database. Select another officer button. This 
will highlight its name and ID number. Select the Delete  icon  at the top of the tab. Select Yes  in the warning to delete 
that button. Right-click an officer button and Select Rename. The officer name will be selected and you can simply 
type a different name. This allows you to reassign officer buttons to different officers or change names as necessary. 
You can delete or rename location and incident buttons using the same method. 

Under the Buttons  tab, scroll down to the Unassigned Buttons  node. Expand the node if necessary, then right click 
Unassigned Button #1  and select Edit. A properties tab will appear. Select the Button Type  field. From the list that 
appears select Officer. Enter a name in the Officer Name  field, and any desired notes. Select the Save  icon  button. 
Notice that Unassigned Button #1  has been removed from the Unassigned Buttons  node. You’ll find the new officer 
under the Officer Buttons  node. Close all properties tabs. 

Guard1 Plus also supports numeric button keypads for use with THE PIPE. Keypads contain 12 touch buttons that 
represent the digits 0 through 9, plus Enter and Cancel keys. This provides the same functionality as readers that have 
fragile data-entry keypads, but in the much more durable form of THE PIPE and touch buttons. 

Continue learning with the Sample data: 

Tutorial part 2: How to make patrols and download patrol data  

Tutorial part 3: Printing reports 

Tutorial part 4: How to select the report you need  

When finished, return to the Master data by selecting the File menu, then select Use Master Data. You can return to 
the sample data at any time. 

Tutorial, part 2 - Making patrols and downloading data 

Guard1 Plus works with several types of readers and downloaders from different manufacturers. In Guard1 Plus these 
are known collectively as devices. This section of the tutorial describes how to make patrols with the supported 
readers and download the collected data into Guard1 Plus. After patrol data are downloaded you can view this 
information on-screen and print a variety of reports. Printing is covered in part 3 of the tutorial. 

 Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 

Making patrols: 

Part 1 of the tutorial describes adding buttons to Guard1 Plus. These are organized as location, incident, and officer 
buttons. Tell me more about types of buttons. When making a patrol, the officer will first read his or her officer button. 
This establishes who made the patrol. The reader records the date and time each button was read, so if the officer 
reads his or her button at the beginning of the patrol, it also establishes when the patrol was started. The officer will 
then begin patrolling the required locations, reading those locations’ buttons. This establishes where officer visited, 
along with the date and time. If any incident is found at any location, the officer will read an incident button that 
describes the problem or condition found. This establishes what the officer found. Guard1 Plus allows adding incident 
buttons with duplicate descriptions. You can create several sets of incident buttons which several officers can carry on 
patrols, usually in a wallet, attached to a clipboard, etc. 

For more information about adding locations to clients, facilities, and groups, see part 1 of the tutorial. 

 The use of incident buttons is optional. If your organization does not need to report incidents, you do not need to 
add incident buttons to Guard1 Plus. 

 This method of reading buttons is important; doing this properly will prevent confusion when reports are printed 
later. For example, if an officer reads an incident button before reading any location, the incident will not appear in 
Incident Reports. To view the incident it would be necessary to print a Download Report, which always shows all 
buttons read, regardless of type. 

If you have a reader, downloader, and buttons available, read a few buttons (or strips, stations, or checkpoints) now. In 
the next section, these will be downloaded and types and descriptions will be assigned. 

Downloading patrol data: 
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Before you can download a reader, you must have a downloader installed on your computer and added to Guard1 
Plus. The Add Devices Wizard will take you through this process and automatically add your devices. Tell me more 
about adding devices. This section assumes you have a locally-connected downloader installed on your computer and 
added to Guard1 Plus, and that you are working with the sample data.  to load the sample data.  

Downloading is handled by a component of Guard1 Plus called the Attendant. The Attendant must be running in order 
to download. By default, the Attendant starts when you start Guard1 Plus. You can tell the Attendant is running by 
noting its icon  in the Windows taskbar, near the clock. The Attendant has a number of options you can set to control 
the way downloading is done. Tell me more about the Attendant.  

Place your reader in the downloader. For many types of devices, this is all that’s needed to download the reader. If 
your device supports insert detection it will be automatically downloaded. If your reader is not automatically 
downloaded when you place it in the downloader, you will have to start the download manually. This too is very simple 
to do: right-click the Attendant’s icon in the Windows taskbar. From the menu that appears, point to Download. A 
second menu will appear from which you should select your downloader. The data will be downloaded, and the 
progress of the download will be displayed. The reader will then be cleared and its internal clock reset to match your 
computer’s clock. When this is complete you can remove the reader from the downloader. When working with actual 
patrols, you can continue to download additional readers as needed. If Guard1 Plus is running it will process the data. 
If it is not, the data will be processed the next time Guard1 Plus is started. 

Because you are currently working with the sample data, the Download into Sample Data Wizard will start. The 
purpose of this Wizard is to protect you from downloading a reader containing important patrol data into the sample 
data. Follow the Wizard’s instructions. Since you are working with test data for this tutorial, select the Put my data in 
the sample database choice, and then finish the Wizard. When working with actual patrol data, you would probably 
want to select one of the other options. For help with the Wizard’s panels, select the Help button on each panel. 

 When you download a reader into the sample data, that download not available when you return to the Master 
data. The reader is cleared after a successful download, so make sure you direct this Wizard to save the data in the 
correct file. 

 When you are working with the Master data (for normal daily work), this Wizard will not appear. It is assumed that 
the patrol data should be downloaded into the Master data file. 

In the case of actual patrol data, it is very likely that all of the buttons read will already have been added to Guard1 
Plus. In these cases, the data are processed by Guard1 Plus and you can immediately view or print the downloaded 
data. If the downloaded data contain buttons that are unknown to Guard1 Plus, the Assign Names Wizard will 
automatically start. If you have followed this tutorial and downloaded a reader into the sample data, the buttons in the 
downloaded are probably unknown, so this Wizard will start. Follow the Wizard’s instructions to add these buttons as 
locations. For help with the Wizard’s panels, select the Help button on each panel. 

You can make additional "patrols" with your sample buttons and download the data. If you read the same buttons as 
before, the Assign Names Wizard will not appear. 

Continue learning with the Sample data: 

Tutorial part 3: Printing reports  

Tutorial part 4: How to select the report you need  

Tutorial part 1: Setting up clients, facilities, groups, and adding buttons  

When finished, return to the Master data by selecting the File menu, then select Use Master Data. You can return to 
the sample data at any time. 

Tutorial, part 3 - Printing or previewing reports 

After you have downloaded patrol data you’ll want to print reports. Guard1 Plus includes an extensive array of report 
types. You can also view your downloaded data on-screen, either as a list on a properties tab or in a format matching 
the printed reports. The sample data includes the standard reports, and also includes several custom reports. This part 
of the tutorial will explore these and also describe how to create new reports. 

If you have not loaded the sample data, do so now. .  

 Some printing and previewing options are available only during the trial period or after the Rules and Advanced 
Reports module is activated. Otherwise they are disabled ("grayed out"). Also, you must have Microsoft Word 97 or 
later installed on your computer in order to print or preview reports with these options and styles. If Word is not 
installed only the Dot Matrix style of reports will be available. On-screen preview is not available for Dot Matrix style 
reports. Tell me about software modules.  

 Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 

The simplest report is the Download Report for a single download. This report will show all of the records (button, 
strip, station, or checkpoint reads) from one download of a device (reader or downloader). It will include all locations, 
incidents, and officers read. For each button in the download, the report will show the description, date and time read, 
the button type, and button’s ID number. The report will also display information about the device. 

To print a single download, select the Downloads tab and expand (if necessary) the Guard1 Plus node. . All of the 
downloads in the sample data will be displayed. If you downloaded a reader in part 2 of this tutorial, you will see that 
download at the top of the list. Double-click that or any other download. A properties tab will appear for the download 
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with the Summary sub-tab displayed. This will show statistics for the download. Select the Detail sub-tab to view the 
records in the download. To print a Download Report, select the Print icon  button on the tab’s toolbar. 

You can print this report for several downloads if desired. To do this, right-click the Guard1 Plus node or select 
Downloads on the main menu. From the menu that appears, select View All Downloads. A properties tab will appear 
with all downloads displayed. From this list select the downloads you want to print. To select a continuous range of 
downloads, select the first download to be printed. Hold down the shift key, then select the last download to be printed. 
All downloads between these two will be selected. To select a non-continuous range, hold down the Ctrl key, then 
select each download you want to print. 

When you’ve made your selections, select the Print icon  button on the tab’s toolbar. The standard Download Report 
will print for each download using your default style settings. 

You can print a Download Report for a range of dates. This will give you a single report that can include any number 
of downloads. This requires creating a custom report. To do this, select the Reports tab. Expand the Tour Reports 
node, then double-click the Download Report icon. A properties tab will open. You can give this report a unique name 
so you can easily find at use it later. Set the date and time ranges as desired. Select the Quick Help icon  button on 
the tab’s toolbar for information about all of the tab’s fields and buttons. When this report is saved it will appear under 
a Tour Reports node under the Custom Reports node. You can print or preview on-screen this report as needed. It will 
include only downloaded patrol data that were read within the date range you’ve set. Press the F2 key to close all 
properties tabs. 

When you print a Download Report for a range of dates, all patrol data within that range are shown sorted by date 
and time, even if the data came from several readers that were in use at the same time. The report will show the patrol 
stops (location buttons) in the order in which they were read without regard to the different devices that read them. To 
view a Download Report for an individual download, that is, the data downloaded from a single reader (or Mobile or 
Modem Downloader), print the report by selecting a download on the Downloads tab as previously described. 

When you create a custom report for a particular client, facility, or group, the report will appear under that parent client, 
facility, group on the Facilities tab. Select the Facilities tab to bring it to the front. Expand the GEM Manufacturing 
client and the Building Tour group under that client. You will see a number of reports available. To print or preview a 
report, right-click the report. Select Print to print the report or Print Preview  to view the report on-screen. Note that the 
preview function is not available for the Dot Matrix report style. If you want to alter the date range, appearance, or 
other settings, select Edit to open the report’s properties tab. Select the Quick Help icon  button on the tab’s toolbar for 
information about all of the tab’s fields and buttons. 

Create a custom report for a facility of Metropolitan Clinic. To do this, bring the Facilities tab to the front, expand the 
Clients node, and then expand the Metropolitan Clinic client. Right-click the Main Campus facility. From the menu that 
appears, select Reports , then select Incident Report from the second menu. A properties tab will appear for the 
report. Enter Tutorial Incident Report in the Name field. Select the Specific Dates option, then set the From  date to 
July 1, 2000 and the To  date to July 30, 2000. Select the Appearance sub-tab, and then select Professional from the 
Style list. 

 All of the styles except Dot Matrix require Microsoft Word 97 or later and the Rules and Advanced Reporting 
module. 

Select the Quick Help icon  button on the tab’s toolbar for information about all of the tab’s fields and buttons. Select 
the Save icon  button to save this new report. An icon for the report will appear under the Main Campus facility. To 
print the report select the Print icon  button on the properties tab toolbar. To preview the report on-screen, select the 
Print Preview icon  button. Note that preview is not available for reports in the Dot Matrix style. 

You can create, save, and print or preview other types of reports as described above. 

Continue learning with the Sample data: 

Tutorial part 4: How to select the report you need  

Tutorial part 1: Setting up clients, facilities, groups, and adding buttons  

Tutorial part 2: How to make patrols and download patrol data  

When finished, return to the Master data by selecting the File menu, then select Use Master Data. You can return to 
the sample data at any time. 

Tutorial, part 4 - How to choose a report 

Part 3 of the tutorial described the basics of customizing and printing reports; it gives you the "how to" information for 
creating reports. Before setting up custom reports you should think about the information you want to present, and 
then choose the type of report that will do that in the most efficient manner. This part of the tutorial will describe the 
types of reports and help you choose the best report for a given purpose. 

 Some of the functionality described below, including setting appearance options, filtering, using rules, and saving 
customized reports, is available only during the trial period or after the Rules and Advanced Reporting module is 
activated. Tell me about software modules.  

 Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 

LISTING REPORTS are the simplest of the reports. If you want to see a list of all buttons in your system, or only the 
incident buttons, or the officer buttons, or the location buttons, print the appropriate listing. You can also print listings of 
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unassigned and unassociated location buttons. If Rules and Advanced Reporting is activated, you can set 
appearance options for these reports and save them with custom names. 

The sample data includes a custom Location Listing Report you can print. This has been set up using the Business 
style, will print a logo and watermark, and will include statistics. To see this report, load the sample data file. . Select 
the Reports tab to bring it to the front, and then expand the Custom Reports node and the Listings node under it. . You 
will then see the Location Listing Report icon . To print or preview (on-screen) this report, right-click its icon. From the 
menu that appears select Print or Print Preview. To see how this report has been set up, right-click its icon and select 
Edit. A properties tab for the report will open. You can view the settings on the General and Appearance sub-tabs. 
Select the Quick Help icon  button to learn about the fields and buttons on these tabs. 

 Listing reports do not contain any patrol data. These reports are simply lists of the buttons in your system. 

TOUR REPORTS will show patrol data that have been collected with any of the supported readers and downloaded 
into Guard1 Plus. 

The simplest Tour report is the Download Report. This is a list of all patrol data that have been downloaded into 
Guard1 Plus. You can set a date range so you can "zero in" on specific data by date or time. You can also print 
Download Reports for specific downloads, so you can see all of the patrol data from a specific reader (or readers in 
the case of Mobile or Modem Downloaders). 

When you print a Download Report for a range of dates, all patrol data within that range are shown sorted by date 
and time, even if the data came from several readers that were in use at the same time. The report will show the patrol 
stops (location buttons) in the order in which they were read without regard to the different devices that read them. 
You can print a Download Report for an individual download. To do this, select the Downloads tab. You will see all 
downloads in the sample data. You can scroll through them and see the dates and times for each; this is the date and 
time for the actual download of the reader, not the dates and times for the records (patrol stops) in the reader. To print 
a report for a download, right-click the download. From the menu that appears, select Print Download Report. 

Because other types of reports can have filters applied that limit the patrol data printed, it may appear that some data 
are missing when these reports are printed. A Download Report can’t be filtered, so within a given date and time 
range you will see all downloaded data. If Rules and Advanced Reporting is activated, you can set appearance 
options for Download Reports and save them with custom names. 

• Any time you suspect some patrol data are missing or not being correctly reported, print a Download Report for the 
date range in question. If the "missing" data are there, check the date ranges and filters on the other reports. 

The Incident Report displays only patrol stops at which an incident was reported. The report shows the officer, the 
location, and the incident. If Rules and Advanced Reporting is activated, you can set appearance options for these 
reports and save them with custom names, and also set filters to further limit the patrol data included in the report. If 
your organization does not use incident buttons, you will have no use for the Incident Report. 

• If you need a report that highlights the incidents found during patrols, print an Incident Report. 

The Officer, Location Report displays patrol data starting with the officer who made the patrol, then lists all locations 
that officer visited. Any incidents reported are not included in this report. If Rules and Advanced Reporting is 
activated, you can set appearance options for these reports and save them with custom names, and you can set filters 
to show only patrols made by specific officers or groups of officers. You can also set filters for specific locations if 
desired. 

• If you need a report that focuses on officers and the locations they’ve visited, print an Officer, Location Report. 

The Officer, Location, Incident Report displays patrol data starting with the officer who made the patrol, then lists all 
locations that officer visited and any incidents reported. If Rules and Advanced Reporting is activated, you can set 
appearance options for these reports and save them with custom names, and also set filters to further limit the patrol 
data included in the report. If your organization does not use incident buttons, you can print the Officer, Location 
Report instead. 

• If you want a report that shows everything about a patrol, print an Officer, Location, Incident Report. 

The sample data includes several custom Tour Reports you can print. These have been set up using the Dot Matrix 
and the Business styles. All will include patrol statistics, and the Business style reports will print a logo and watermark. 
To see these reports, load the sample data file. . Select the Reports tab to bring it to the front, and then expand the 
Custom Reports node and the Tour Reports node under it. . You will then see the icons for several reports. To print or 
preview (on-screen) a report, right-click its icon. From the menu that appears select Print or Print Preview. Note that 
reports in the Dot Matrix style can’t be previewed, so the Print Preview menu item is disabled for those reports. To see 
how a report has been set up, right-click its icon and select Edit. A properties tab for the report will open. You can view 
the settings on the General and Appearance sub-tabs. Select the Quick Help icon  button to learn about the fields and 
buttons on these tabs. 

RULE-BASED REPORTS can be printed to show the actual rules, patrol activity against rules, and exceptions. You 
must add rules to clients, facilities, groups, or locations before you can create rule-based reports. 

The Rule Itinerary Report prints a complete description of each rule. It will show how the rule is filtered, grouped, and 
sorted. It will show the date and time periods for the rule, the valid from and valid to dates, the locations to which the 
rule applies, and the expected number of visits. If there is a map for the rule it will appear on the report. If the locations 
have photos associated with them, the photos will print on this report. 
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 Rule Itinerary Reports do not contain any patrol data. These reports simply describe the rules. Also note that if 
these reports are printed using the Dot Matrix style, photos and maps will not be printed. 

• If you want to see all details about a rule, print a Rule Itinerary Report. 

The Rule Activity Report displays some detail about the rule and shows the expected number of visits and the actual 
number of visits for all locations to which the rule applies. When you add a rule to Guard1 Plus, you must set a 
schedule (time and date range) and detail (the expected number of visits to locations) for the rule. The Rule Activity 
Report will print all of this information for the rules associated with the parent client, facility, group, or location. 

• If you want to see rule detail and the expected and actual number of visits to all locations to which a client’s, 
facility’s, group’s, or location’s rules apply, print a Rule Activity Report. 

The Rule Exception Report is similar to the Rule Activity Report, but displays only locations for which the actual 
number of visits is less than the expected number. It shows only the exceptions to the rule(s). 

• If you want to gauge the performance of your officers by tracking when they have missed important locations, add 
appropriate rules to Guard1 Plus and print a Rule Exception Report. This is the most useful of the Rule-based 
reports and is the primary reason to set up rules in your system. 

The sample data file includes several custom Rule-based Reports you can print. These have been set up using the 
Business style, will print a logo and watermark, and will include statistics. To see a report, load the sample data file . 
Select the Reports tab to bring it to the front, and then expand the Custom Reports node and the Rule Reports node 
under it. . You will then see the icons for several reports. To print or preview (on-screen) a report, right-click its icon. 
From the menu that appears select Print or Print Preview. To see how a report has been set up, right-click its icon and 
select Edit. A properties tab for the report will open. You can view the settings on the General and Appearance sub-
tabs. Select the Quick Help icon  button to learn about the fields and buttons on these tabs. 

COVER SHEET REPORTS are available in two types. If you present printed reports to clients or to your organization’s 
management, you can add a professional touch by including a cover sheet with the reports. Cover Sheet reports 
include Presented by (or From) information and Presented to (or To) information. You can customize and save these 
reports so they can be printed whenever needed with minimum additional effort. 

• If the printed reports are hand-delivered or mailed, use the Report Cover Sheet. 

• If the reports are to be faxed, use the Fax Cover Sheet. This includes spaces into which you can hand-write the 
number of attached pages and add notes. 

When finished experimenting with the sample data, return to the Master data by selecting the File menu, then select 
Use Master Data. You can return to the sample data at any time. 

 

About buttons and button types 

 Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 

Guard1 Plus uses several types of buttons. Each of these is a button type: 

Officer: An officer button identifies an officer. It is usually kept by the officer on an ID badge or key ring. Guard1 Plus 
uses this icon to identify officer buttons: . 

Location: A location button identifies a location. It is installed at a checkpoint to be visited during an officer’s patrols. 
Guard1 Plus uses these icons to identify locations:  (THE PIPE touch buttons),  (Deister checkpoints),  (Morse 
stations),  (Detex/GCS strips). 

Incident: An incident button indicates an observed problem or other note by the officer. Incident buttons must be 
defined in advance and carried by the officer during patrols. Guard1 Plus allows you to create duplicate sets of 
incident buttons for use by several officers. Guard1 Plus uses this icon to identify incident buttons: . 

Unassigned: Buttons which have been read or downloaded into Guard1 Plus but not yet assigned a type and 
description are automatically given a type of unassigned. Unassigned button, station, strip, and checkpoint icons 
appear as shown:    . 

Before using a button you must tell Guard1 Plus what it represents. 

Keypad: The Keypad Module in Guard1 Plus allows setting up numeric button keypads for use with THE PIPE. 
Keypads contain 12 touch buttons that represent the digits 0 through 9, plus Enter and Cancel keys. The buttons for 
each keypad would be carried by patrol officers in wallets, attached to clipboards, etc. Patrol officers can then enter 
locations, such as room numbers, as well as incidents and officers by reading buttons on the keypad. 

Buttons 

Buttons tab -- overview 

Buttons are used to represent officers, the locations they visit, incidents they report, and other information. These 
buttons are added to Guard1 Plus and given descriptions or names to indicate their meaning. The buttons are placed 
at the patrol stops in the field. Officers making patrols read these buttons with THE PIPE or other type of reader, then 
the reader is downloaded into Guard1 Plus. The permanent button ID numbers in the downloaded data are matched 
with the descriptions in the software. 
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 Throughout the on-line Help the term button is used to indicate "Touch Memory button", "strip", "station", or 
"checkpoint", as used by the makers of the various readers supported by Guard1 Plus. Some features of Guard1 
Plus apply only to Touch Memory buttons, and this will be indicated where required. 

Guard1 Plus separates buttons into several types. These are identified by different icons and are displayed under 
nodes on the Buttons  tab. Tell me about types of buttons.  

The Buttons tab displays your organization’s location, incident, and officer buttons under separate nodes. Unassigned  
locations will also be displayed on the Buttons  tab. 

  Select the Buttons  tab to bring it to the front. 

You will see the treeview with the nodes for Location Buttons, Incident Buttons, Officer Buttons, and Unassigned 
Buttons. If there are any buttons in your system, a small icon will be seen next to the appropriate node. If it is a plus 
icon , select it to expand the node so you can see the buttons. When the node is expanded the icon will change to a 
minus . Select this to "collapse" the node. 

All treeviews in Guard1 Plus are hierarchical in nature – they look very much like the familiar Windows Explorer 
included with Microsoft Windows. Show me. At the top level is the System  node, called Guard1 Plus. Location 
Buttons, Incident Buttons, Officer Buttons, and Unassigned Buttons nodes appear under the System node. You can 
add buttons of any type to Guard1 Plus at any time. You can print button "listing" reports for all buttons or for a specific 
type (Locations only, or Officers only, for example). You can edit buttons to change their descriptions or types. You 
can also use Cut and Paste to move buttons from one node (button type) to another. The Change Button Wizard will 
help with this. 

If you have the capability to make digital images, either by drawing or scanning them, using a digital camera, or by 
downloading from the Web, you can add these to your location button information in Guard1 Plus. These could show 
actual button locations, the conditions to which incidents apply, etc. These images will print on the Rule Itinerary 
Report. 

 This report is available during the trial period or after the Rules and Advanced Reporting module is activated. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

Before using a button you must tell Guard1 Plus what it represents. There are several ways to do this, and the method 
you use depends on whether the buttons are already installed at patrol stops, and whether or not they are Touch 
Memory buttons to be used with THE PIPE, or the stations, strips, or checkpoints used by other types of readers 
supported by Guard1 Plus. 

 

Using pictures with buttons 

You can add up to three photographs or other digital images to each Location button. Why would I want to do that?  

You can draw images "freehand" using any graphics software, or you can use a digital camera or scanner to get 
images into your computer. Guard1 Plus supports several types of graphics files: 

• Bitmap images (*.bmp, the default) 

• GIF images (*.gif) 

• JPEG images (*.jpg) 

• Windows Metafile images (*.wmf) 

• Enhanced Metafile images (*.emf) 

When creating image files, be sure to save the files in one of the above listed formats. 

 You must create the image file and save it before you can add the image to a button. Guard1 Plus stores only a 
reference to the location of the graphic file. If you delete the file, Guard1 Plus will not be able to display the photo. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

To add a graphic or photograph to a button: 

1 Select the Buttons  tab to bring it to the front. 

2 Expand the Location Buttons node and find the location button for which you have images. . Double-click that button 
to open its properties tab. 

 If a message indicates there are too many tabs open, close one or more properties tabs by selecting the Close icon  
at the right end of the tab’s toolbar. Then repeat step 1. 

3 Select a Photo  sub-tab. This can be any one of the three available. Select one that does not currently have a 
photo. If you want to replace an existing photo, select the Remove  button on that photo’s tab. 

4 Select the New… button. A File Open dialog box will appear. In the Files of type:  field, select the type of file you 
want to open (*.bmp, *.gif, *.jpg, *.wmf, or *.emf). Locate the image file and select Open. The image will appear in 
the image area. It will be resized as necessary to fit. The Image icon  will appear on the tab to indicate a photo is 
present. 
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5 Enter an appropriate description into the Photo Description  field. 

6 Select the Save   icon to save the button information. You can close the properties tab if desired by selecting the 
Close  icon  on the tab. 

 Select the Print  button to print the image. 

 Select the Remove  button to remove the image from Guard1 Plus. The image file is not deleted from your hard disk, 
but the reference to it is removed from Guard1 Plus. 

 When you add a photo to a location, the photo (image file) itself is not stored within Guard1 Plus. Only the path to 
that photo’s file is stored. This image file could be on your local hard drive, a removable media drive (such as a 
floppy disk, Zip disk, or CD-ROM), or a network drive. If you see the "Image not available" message in the photo 
area, the image file is no longer where Guard1 Plus expects to find it, possibly because the network or disk is not 
available or the file has been deleted. If you restore the network connection, insert the removable media, or restore 
the deleted file, the original photo will appear as it should. 

 

Viewing or printing lists of buttons 

You can view a list of all buttons of each type displayed on the Buttons  tab. You can also print a list report of all 
buttons in your system, or limit the report to Locations only, Incidents only, Officers only, or Unassigned buttons only. 

To view or print lists of buttons: 

1 Select the Buttons  tab to bring it to the front. 

2 To print a report listing all buttons, right-click the Guard1 Plus node and select Print Button Listing  from the menu 
that appears. 

3 To print a report listing all buttons of a type (Location, Incident, or Officer), right-click the node for that type, then 
select Print Location (or Officer, or Incident) Listing. 

4 To view a list of all buttons of a type (Location, Incident, Officer, or Unassigned), right-click the node for that type, 
then select View All Location (or Officer, or Incident or Unassigned) Buttons. This will display a properties tab with 
all buttons of the selected type displayed. You can sort this list by button name by clicking the Name  column 
heading. You can sort by ID number by selecting the ID Number  column heading. 

 If a message indicates there are too many tabs open, close one or more properties tabs by selecting the Close  
icon  at the right end of the tab’s toolbar. Then repeat step 4. 

 You can print the listing report while viewing the properties tab by selecting the Print  icon  button on the tab’s 
toolbar. 

 You can view the properties of buttons by selecting from the list, then selecting the Properties  icon  button on the 
tab’s toolbar. This will display a properties tab for all selected buttons. You can select a range of buttons by 
selecting the first button in the range, then holding down the Shift key while selecting the last button in the range. 
You can select individual buttons by holding down the Ctrl key as you select the buttons. 

 You can delete buttons by selecting from the list, then selecting the Delete  icon  button on the tab’s toolbar. You 
can select more than one button to delete as described in the step above. 

If you are installing unassigned buttons in the field, it can be helpful to print a listing of these. You can then write the 
unassigned button numbers on the Setup Card prior to installing the buttons at the patrol stops. 

 

Installing buttons using the Setup Card 

You can use Setup Cards to make adding new location buttons fast and easy. These cards are useful for touch-
memory buttons only. In the spaces provided on the card you can write the descriptions (names you assign) of 
buttons. You can then attach the buttons to the card adjacent to those descriptions. When you’ve defined all the 
buttons for a patrol, you can take the cards to each patrol stop, remove the correct button from the card and attach it to 
the patrol stop. 

To print Setup Cards: 

 The Setup Card "report" is available during the trial period or after the Rules and Advanced Reporting module is 
activated. Also, printing the Setup Card requires Microsoft Word 97 (or later) 

1 Select the Reports  tab to bring it to the front. 

2 Expand the Standard Reports node, then expand the Other  node. . You will see the Setup Card under the Other  
node. 

3 Right-click Setup Card, then select Print from the menu that appears. You can print as many copies as necessary or 
print one and photocopy it as required. 

To use Setup Cards: 

1 If desired, complete the top section of the card with the client or facility name and address, etc. This will help 
eliminate confusion if you are setting up buttons for several clients or facilities in one session. 

2 Remove an adhesive "dot" from the roll or sheet and apply the dot to the Setup Card. Show me.  
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3 If you have entered button descriptions into Guard1 Plus, write the description for this button in the space provided 
on the card. If your buttons are already in Guard1 Plus as "unassigned", put the unassigned button numbers in the 
Button No. blanks, starting with the first unassigned button number from Guard1 Plus.  to find this. 

4 Remove the top liner from the adhesive dot on the card and apply a button to the dot. 

5 Repeat steps 1 through 4 for your remaining buttons. 

6 Take the cards of buttons into the field to the patrol stops. 

7 Remove a button, with the adhesive dot attached, from the card. Show me. Apply the button to the installation site 
and press firmly in place. 

 For a more secure installation, plastic button mounts/holders are available which can be placed over buttons and 
fastened in place with screws. 

8 If the buttons are unassigned, write a description of the location for each button into the space provided. This will be 
used when you return to the office and enter the descriptions into Guard1 Plus. 

 Be sure to write the descriptions next to the correct button number. 

 

Changing button types or descriptions 

After you’ve added buttons to Guard1 Plus, you can change (edit) most of their properties whenever necessary. You 
can change the button type, for example, from an incident button to a location button, or from an unassigned button to 
any other type. You can edit a button’s description to fix typos, change an officer’s name, or move location buttons 
from one physical location to another. You can assign button types and names to unassigned buttons. Finally, you can 
edit the notes on a button’s properties tab. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

To edit a button’s properties: 

1 Select the Buttons  tab to bring it to the front. 

2 Expand the node for the type of button you want to work with. . Locate and double-click that button to open its 
properties tab. 

 If a message indicates there are too many tabs open, close one or more properties tabs by selecting the Close icon  
at the right end of the tab’s toolbar. Then repeat step 2. 

3 Make the necessary changes to the fields on the button’s properties tab. 

4 Select the Save   icon to save the button information. You can close the properties tab if desired by selecting the 
Close  icon  on the tab. 

You can also use Cut and Paste to move buttons from one node (button type) to another. The Change Button Wizard 
will help with this. .  

 

Location information 

These fields appear on the properties tab for a location button. You can change the information in these fields at any 
time. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

ID Number 

This is the ID number (or Custom Button number for keypad locations), of the button. You can’t change this 
information. 

Button Type 

Determines what this button will represent; Location, Officer, Incident, or Unassigned. Select the field to pop up a list 
from which you can select a type. 

Description 

Describes where this button is placed (for example, "Main Lobby" or "Fire Extinguisher #204"). 

Notes 

This field is available for you to enter any optional information about the location, such as details about its placement 
("inside the stairwell") or instructions to the officer ("check that the coffee maker is turned off"). 

Member of 

If this location is associated with any client, facilities, and/or groups, you will see Member of buttons below the Notes  
field for those "parent" items. These buttons will display the name of the parent client, facilities, or groups. You can’t 
change this information on the Location properties tab, but if you change then name of the parent client, facility, or 
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group, the Member of button(s) will change to match. Selecting any of these buttons will open a properties tab for the 
parent item. 

Tell me more about clients, facilities, and groups.  

Select the Save   icon to save the button information. You can close the properties tab if desired by selecting the Close  
icon  on the tab. 

Tell me about the Photo tabs across the bottom of this properties tab.  

 

Incident information 

These fields appear on the properties tab for an incident button. You can change the information in these fields at any 
time. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

ID Number 

This is the ID number (or Custom Button number for keypad incidents), of the button. You can’t change this 
information. 

Button Type 

Determines what this button will represent; Location, Officer, Incident, or Unassigned. Select the field to pop up a list 
from which you can select a type. 

Incident Type 

Select the field to choose from the list of previously entered incident types, or enter a new incident type. Because any 
number of officers will need a "set" of incident buttons, you can have duplicate buttons for any incident type. 

Notes 

This field is available for you to enter any optional information about the button, such as instructions to the officer 
("always report broken windows to maintenance department"). 

Select the Save   icon to save the button information. You can close the properties tab if desired by selecting the Close  
icon  on the tab. 

 

Officer information 

These fields appear on the properties tab for an officer button. You can change the information in these fields at any 
time. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

ID Number 

This is the ID number (or Custom Button number for keypad officers), of the button. You can’t change this information. 

Button Type 

Determines what this button will represent; Location, Officer, Incident, or Unassigned. Select the field to pop up a list 
from which you can select a type. 

Officer Name 

Select the field to choose from the list of previously entered officer names, or enter a new officer name. Because a 
button might need to be installed in several locations (vehicle, locker, ID badge, key ring, etc.) or be replaced when 
lost, you can have duplicate buttons for an officer name. 

Notes 

This field is available for you to enter any optional information about the button, such as information about the officer 
("home phone number is …") or the button ("replaces button lost on October 12

th
, 2000"). 

Select the Save   icon to save the button information. You can close the properties tab if desired by selecting the Close  
icon  on the tab. 

 

Unassigned buttons information 

These fields appear on the properties tab for an unassigned button. You can change the information in these fields at 
any time. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  
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ID Number 

This is the ID number (or Custom Button number for keypad buttons), of the button. You can’t change this information. 

Button Type 

Determines what this button will represent: location, officer, or incident. Select the field to pop up a list from which you 
can select a type. If you select location, officer, or incident from the list, a new field will appear so you can enter a 
name or description for the button. 

Notes 

This field is available for you to enter any optional information about the button. 

Select the Save   icon to save the button information. You can close the properties tab if desired by selecting the Close  
icon  on the tab. 

 

Changing button types using Cut and Paste 

You can change buttons from one type to another by using cut and paste to "move" buttons. This works very much like 
moving words in a text document from one paragraph to another using your word processor’s cut and paste controls. 

For example, to change a location button into an incident button, you select the location button, cut it, select the 
Incident Buttons node, and paste the button there. A Wizard will help change the type from location to incident. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

To change a button’s type using cut and paste: 

1 Select the Buttons  tab to bring it to the front. 

  To change a single button: Expand the node for the type of button you want to move. . For example, if you want to 
change an unassigned button into a location button, expand the Unassigned Buttons node. Locate and select (click 
once) the button to be moved. 

  To change several buttons at once, for example, to change several unassigned buttons to location buttons: Right-
click the node for the type of button you want to move. From the menu that appears, select View All 
<Location/Incident/Officer/Unassigned> Buttons. A properties tab will open and display all buttons of the type 
selected. You can select a range of buttons by selecting the first button in the range, then holding down the Shift 
key while selecting the last button in the range. You can select individual buttons by holding down the Ctrl key as 
you select the buttons. 

2 On the main toolbar, click the Cut  icon  button. If the Cut  button is disabled ("grayed out"), either you have not 
selected a button to move, or the button(s) you have selected can’t be moved. You can also hold down the Ctrl key 
and press the X key to cut the button(s). 

3 Select (click once) the node into which you want to paste the button. Using the example in step 1, you would select 
the Location Buttons node. 

4 On the main toolbar, select the Paste  icon  button. You can also hold down the Ctrl key and press the V key to 
paste the button(s). The Change Button Wizard will start. 

5 Follow the Wizard’s instructions to complete changing the button type. You can also change the description and 
notes if desired. 

 

Locations, incidents, and officers 

 Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. 

Guard1 Plus uses several types of buttons. Each of these is a button type: 

Officer: An officer button identifies an officer. It is usually kept by the officer on an ID badge or key ring. Guard1 Plus 
uses this icon to identify officer buttons: . 

Location: A location button identifies a location. It is installed at a checkpoint to be visited during an officer’s patrols. 
Guard1 Plus uses these icons to identify locations:  (THE PIPE touch buttons),  (Deister checkpoints),  (Morse 
stations),  (Detex/GCS strips). 

Incident: An incident button indicates an observed problem or other note by the officer. Incident buttons must be 
defined in advance and carried by the officer during patrols. Guard1 Plus allows you to create duplicate sets of 
incident buttons for use by several officers. Guard1 Plus uses this icon to identify incident buttons: . 

Unassigned: Buttons which have been read or downloaded into Guard1 Plus but not yet assigned a type and 
description are automatically given a type of unassigned. Unassigned button, station, strip, and checkpoint icons 
appear as shown:    . 

Before using a button you must tell Guard1 Plus what it represents. 

Tell me about adding buttons and assigning names and types. 
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Buttons menu 

The Buttons menu provides the following commands: 

 

View All Locations Opens a properties tab that displays all location buttons in 
your data. You can print a Location Button Listing from 
the properties tab, and double-click any location button to 
open its properties tab. 

View All Incident Buttons Opens a properties tab that displays all incident buttons in 
your data. You can print an Incident Button Listing from 
the properties tab, and double-click any incident button to 
open its properties tab. 

View All Officer Buttons Opens a properties tab that displays all officer buttons in 
your data. You can print an Officer Button Listing from 
the properties tab, and double-click any officer button to 
open its properties tab. 

View All Unassigned Buttons Opens a properties tab that displays all unassigned 
buttons in your data. You can print an Unassigned 
Button Listing from the properties tab, and double-click 
any unassigned button to open its properties tab. 

View All Unassociated Buttons Opens a properties tab that displays all unassociated 
buttons in your data. You can print an Unassociated 
Location Button Listing from the properties tab, and 
double-click any unassociated location button to open its 
properties tab. 

Buttons What's This Help 

Pop-up topics 

Why add photos to buttons? 

For location buttons, you could add photos of the actual site where the button is installed. This could be useful if the 
button is located out of the normal traffic flow or attached to an area that's not easily seen. 

The photos will be included on the Rule Itinerary Report (available during the trial period or when the Rules and 
Advanced Reporting module is activated), which could be given to the officer prior to the patrol. This would show the 
required patrol route (the rule) and the images of the necessary patrol stops. 

Expand or collapse nodes 

Nodes typically have expand/collapse controls you can use to display or hide the items under a "parent", or higher-
level node. Select the  icon to expand a node and display the items under it. The icon will then change to . Select this 
icon if you want to collapse the node. If there is no icon next to the node, the node is empty. 

 

Location button properties tab -- General 

On the location button properties tab you will find several sub-tabs. Select any sub-tab to bring it to the front and 
display its controls and fields. 

On the General sub-tab you can view or make changes to information about a location. The fields on this properties 
tab display the button's type, ID number (or Custom Button number for keypad locations), description, and any notes 
you may have. You can change the type by selecting the Button Type field and selecting from the list that appears. 
You can add or change the other information by selecting the desired field and typing. 

If this location is associated with a parent client, facility, or group, one or more Member of buttons will be displayed 
with the parent client’s, facility’s, or group’s name. Select a button to open a properties tab for that parent client, 
facility, or group. 

When you've completed adding or changing this information, select the Save icon  button on the tab's toolbar. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

 

Location button properties tab -- Photo 

On the location button properties tab you will find several sub-tabs. Select any sub-tab to bring it to the front and 
display its controls and fields. 

On the Photo sub-tabs you can add, view, and print photos associated with locations. The photo must be a graphic file 
of a specific type. You can make graphic files with digital cameras, by drawing with an illustration program, by 
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downloading from the Web, etc. Once the graphic file is available, you can add it to Guard1 Plus. You can have up to 
three photos for a location – all of the Photo tabs work in the same way. 

Photos are especially useful if you have location buttons in hard-to-find areas or in locations that are difficult to 
describe. Photos will print on the Rule Itinerary Report, so you can print these reports and give them to officers prior 
to the start of their patrols. 

When you've completed adding or changing this information, select the Save icon  button on the tab's toolbar. The 
Image icon  will appear on the tab to indicate a photo is present. 

 When you add a photo to a location, the photo (image file) itself is not stored within Guard1 Plus. Only the path to 
that photo’s file is stored. This image file could be on your local hard drive, a removable media drive (such as a 
floppy disk, Zip disk, or CD-ROM), or a network drive. If you see the "Image not available" message, the image file 
is no longer where Guard1 Plus expects to find it, possibly because the network or disk is not available or the file 
has been deleted. If you restore the network connection, insert the removable media, or restore the deleted file, the 
original photo will appear as it should. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

Incident buttons list 

On the incident buttons list tab you can view or print a list of all incident buttons in Guard1 Plus The list displays each 
incident's type (name) and the ID number (or Custom Button number for keypad incidents), of the button that 
represents that incident. You can sort this list by name by clicking the Name column heading. You can sort by ID 
number by clicking that column's heading. 

With the toolbar buttons you can: 

 Delete one or more incident buttons. 

  Select an incident, then select the Delete icon button or press the Delete key on your keyboard. You can select a 
range of buttons by selecting the first button in the range, then holding down the Shift key while selecting the last 
button in the range. You can select individual buttons by holding down the Ctrl key as you select the buttons. 

 Open properties tab(s) for one or more selected incidents. 

  Select an incident, then select the Properties icon button, or simply double-click the incident. You can select a range 
of incidents as described above. 

 Print an Incident Button Listing Report. 

. 

Incident button properties tab 

On the incident button properties tab you can view or make changes to information about an incident. The fields on 
this properties tab display the button's type, ID number (or Custom Button number for keypad incidents), incident type, 
and any notes you may have. You can change the button type by selecting the Button Type field and selecting from 
the list that appears. You can change the incident type by selecting the Incident Type field and selecting from the list 
that appears. This allows you to make duplicate incident buttons. You can also type new incident descriptions into this 
field. You can add or change notes by selecting the field and typing. 

When you've completed adding or changing this information, select the Save icon  button on the tab's toolbar. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

Officer buttons list 

On the officer buttons list tab you can view or print a list of all officer buttons in Guard1 Plus The list displays each 
officer’s name and the ID number (or Custom Button number for keypad officers), of the button that represents that 
officer. You can sort this list by name by clicking the Name column heading. You can sort by ID number by clicking 
that column's heading. 

With the toolbar buttons you can: 

 Delete one or more officer buttons. 

  Select an officer button, then select the Delete icon button or press the Delete key on your keyboard. You can select 
a range of buttons by selecting the first button in the range, then holding down the Shift key while selecting the last 
button in the range. You can select individual buttons by holding down the Ctrl key as you select the buttons. 

 Open properties tab(s) for one or more selected officers. 

  Select an officer button, then select the Properties icon button, or simply double-click the button. You can select a 
range of officer buttons as described above. 

 Print an Officer Button Listing Report. 



 36 

 

Officer button properties tab 

On the officer button properties tab you can view or make changes to information about an officer. The fields on this 
properties tab display the button's type, ID number (or Custom Button number for keypad officers), officer name, and 
any notes you may have. You can change the button type by selecting the Button Type field and selecting from the list 
that appears. You can change the officer name by selecting the Officer Name field and selecting from the list that 
appears. This allows you to make duplicate officer buttons. You can also type new officer names into this field. You 
can add or change notes by selecting the field and typing. 

When you've completed adding or changing this information, select the Save icon  button on the tab's toolbar. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

Unassigned buttons list 

On the unassigned buttons list tab you can view or print a list of all unassigned buttons in Guard1 Plus The list 
displays each unassigned button and its ID number (or Custom Button number for keypad buttons),. You can sort this 
list by name by clicking the Name column heading. You can sort by ID number by clicking that column's heading. 

With the toolbar buttons you can: 

 Delete one or more unassigned buttons. 

  Select an unassigned button, then select the Delete icon button or press the Delete key on your keyboard. You can 
select a range of buttons by selecting the first button in the range, then holding down the Shift key while selecting 
the last button in the range. You can select individual buttons by holding down the Ctrl key as you select the 
buttons. 

 Open properties tab(s) for one or more selected unassigned buttons. 

  Select an unassigned button, then select the Properties icon button, or simply double-click the button. You can 
select a range of unassigned buttons as described above. 

 Print an Unassigned Button Listing Report. 

.  

Unassigned buttons properties tab 

On the unassigned button properties tab you can view or make changes to information about unassigned buttons. The 
fields on this properties tab display the button's type, ID number  (or Custom Button number for keypad buttons), 
description, and any notes you may have. You can change the type by selecting the Button Type field and selecting 
from the list that appears. You can add or change the other information by selecting the desired field and typing. 

When you've completed adding or changing this information, select the Save icon  button on the tab's toolbar. 

 If you have read-only or reports-only access to Guard1 Plus, you will not be able to add, change, or delete button 
information. You must have full access to make changes to the data. Tell me about security and passwords.  

.  

 

File menu 

The File  menu provides the following commands: 

 

Open Backup… Allows you to select a backup data file to open. Guard1 
Plus can open backup files so you can view or print patrol 
data from these files. When a backup file is open its name 
will appear in the status bar at the bottom of the screen. 
You can’t make changes to the data in backup files. When 
finished you can return to the master data file. 

This menu is available only during the trial period or if the 
Data Maintenance module has been activated. 
Otherwise, it is disabled. 

Open Archive… Allows you to select an archive data file to open. Guard1 
Plus can open archive files so you can view or print patrol 
data from these files. When an archive file is open its 
name will appear in the status bar at the bottom of the 
screen. You can’t make changes to the data in archive 
files. When finished you can return to the master data file. 

This menu is available only during the trial period or if the 
Data Maintenance module has been activated. 
Otherwise, it is disabled. 
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Use Master Data When the master data file is open this menu item is 
disabled and checked . If a backup, archive, or sample 
data file is open, select the User Master Data to open the 
master data file. 

Use Sample Data Opens the sample data file. Use this data to help learn 
about Guard1 Plus and for training new users. When the 
sample data is open this menu item is disabled and 
checked , and its name appears in the status bar at the 
bottom of the screen. When finished you can return to the 
master data. 

Print Preview →→→→ Standard Reports 

→→→→ Report Name 

Displays an on-screen preview of the selected report. This 
preview matches the appearance of the printed reports. 
Some types of reports can’t be previewed and will not 
appear on this menu. 

 The reports on this menu will be enabled only during the 
trial period or if the Rules and Advanced Reporting 
module has been activated. 

Print Preview →→→→ Custom Reports 

→→→→ Report Name 

Displays an on-screen preview of the selected report. This 
preview matches the appearance of the printed reports. 
Some types of reports can’t be previewed and will not 
appear on this menu. 

If there are no custom reports this menu will be disabled 
and will display No custom reports defined. 

 The reports on this menu will be enabled only during the 
trial period or if the Rules and Advanced Reporting 
module has been activated. 

Print →→→→ Standard Reports →→→→ 
Report Name 

Prints the selected report using the default settings 
(filtering,appearance, date range, etc.). Some types of 
reports must be set up before printing and will not appear 
on this menu. These can be found on the Reports menu. 

 The reports on this menu will be enabled only during the 
trial period or if the Rules and Advanced Reporting 
module has been activated. 

Print →→→→ Custom Reports →→→→ 
Report Name 

Prints the selected report using the saved settings 
(filtering, appearance, date range, etc.). Only custom 
reports will appear on this menu. 

If there are no custom reports this menu will be disabled 
and will display No custom reports defined. 

 The reports on this menu will be enabled only during the 
trial period or if the Rules and Advanced Reporting 
module has been activated. 

Print →→→→ Batch Reports →→→→ Report 
Name 

Prints the selected batch report. 

If there are no batch reports this menu will be disabled and 
will display No batch reports defined. 

 The reports on this menu will be enabled only during the 
trial period or if the Rules and Advanced Reporting 
module has been activated. 

Exit Closes Guard1 Plus. If you have made any changes to 
properties for buttons, reports, clients, etc. and have not 
yet saved them, you will be asked if you want to save the 
changes. 

 

Edit menu 

The Edit  menu provides the following commands: 

 

Cut   Ctrl+X Cuts the currently selected item so that it can be pasted 
elsewhere. Cutting removes the selected item from its 
current location. You can also hold down the Ctrl key and 
press X to cut. 

Cut is disabled if nothing is selected or if the selected item 
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can’t be cut. 

Copy   Ctrl+C Copies the currently selected item so that it can be pasted 
elsewhere. Because a copy is made, this does not remove 
the selected item from its current location. You can also 
hold down the Ctrl key and press C to copy. 

Copying is disabled if nothing is selected or if the selected 
item can’t be copied. 

Paste   Ctrl+V Pastes the last item that was cut or copied into the 
currently selected node. You can also hold down the Ctrl 
key and press V to paste. 

Pasting is disabled if nothing has been cut or copied, or if 
the selected node can’t accept the last cut or copied item. 

Delete   Del Deletes the currently selected item. You can also press 
the Del (or Delete) key to delete. 

Deleting is disabled if nothing is selected or the selected 
item can’t be deleted. 

Select All   Ctrl+A Selects all items in list views. For example, if you are 
viewing all downloads, selecting this menu or holding 
down the Ctrl key and pressing A will select all downloads 
in the list. 

Edit selection Opens a properties tab for the selected item so you can 
view or make changes to its properties. Edit selection is 
disabled if nothing is selected or the selected item can’t be 
edited. 

 

View menu 

The View  menu provides the following commands: 

 

Toolbar Displays or hides the main toolbar. If the main toolbar is 
displayed, this menu will be checked . Select the menu to 
hide the toolbar. This will remove the check. Select it 
again to display the toolbar. 

If you are using a small monitor you may wish to hide the 
toolbar so you can see more of the items in the treeviews 
and properties tabs. 

Status bar Displays or hides the status bar at the bottom of the main 
Guard1 Plus window. If the status bar is displayed, this 
menu will be checked . Select the menu to hide the status 
bar. This will remove the check. Select it again to display 
the status bar. 

If you are using a small monitor you may wish to hide the 
status bar so you can see more of the items in the 
treeviews and properties tabs. 

Refresh   F5 Refreshes the current view. If you have added, cut, 
copied, pasted, or deleted items, downloaded data, etc. it 
may be necessary to refresh the view before those 
changes can be seen. 

You can also press the F5 key to refresh the view. 

Guard1 Plus Options… Displays the Guard1 Plus Options  window, from which 
you can change various option settings to control the way 
Guard1 Plus works. 

 

Tabs menu 

The Tabs  menu provides the following commands: 

 

Close All Tabs   F2 Closes all properties tabs. This is disabled if no properties 
tabs are open. You can also press the F2 key to close all 
tabs. 

 The Help tab is not a properties tab, so it is unaffected by 
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this menu. 

Close All but the Active Tab   F3 Closes all properties tabs except the active tab. This is 
disabled if no properties tabs are open. You can also 
press F3 to close all tabs but the active tab. 

The note above applies. 

Close Active Tab   F4 Closes only the active tab, that is, the front-most tab. This 
is disabled if no properties tabs are open. You can also 
press F4 to close the active tab. 

The note above applies. 

Tab Name All open properties tabs and the Help tab will be displayed 
at the bottom of the Tabs menu. Select any tab name to 
make that the active (front-most) tab. 

 

Help menu 

The Help  menu provides the following commands: 

 

Help Topics   F1 Opens the on-line help. You can also press F1 to open 
Help. 

Help Tab   Alt+F1 If the Help tab is displayed, this menu command will close 
it. If the Help tab is closed this command will display it. 
The buttons on the Help tab provide easy access to Help 
topics that will get up started quickly with Guard1 Plus. 

You can also hold down the Alt key and press F1 to open 
or close the Help tab. 

What’s This?   Shift+F1 Starts What's This? Help. The cursor will change to . 
Select any button, tab, field, or other control with this 
cursor to see a brief description of the control. 

If a control is already selected you can hold down the Shift 
key and press F1 to see What’s This? Help. 

Guard1 Plus Home Page If you have a connection to the Internet, select this 
command to view the Guard1 Plus home page on the 
Web. 

 You must establish a connection to the Internet before 
using this command. You may need to dial a service 
provider, or you may have a full-time connection via your 
internal network, cable modem or DSL, etc. 

Guard1 Plus Support Page If you have a connection to the Internet, select this to enter 
the Guard1 Plus Support Page on the Web. 

This menu item is enabled only if you have a current 
support subscription. If you have not purchased a support 
subscription, or if your subscription has expired, this menu 
item will be disabled. You will not have access to the 
Support Page. 

You must establish a connection to the Internet before 
using this command. 

  

Data Maintenance Wizard   Ctrl+D Starts the Data Maintenance Wizard. This Wizard will help 
with performing data maintenance, backup and restore 
operations, and data archiving. You can also start the 
Wizard by holding down the Ctrl key and pressing D. 

This menu is available only during the trial period or if the 
Data Maintenance module has been activated. 
Otherwise, it is disabled. 

Activate Software Wizard Starts the Activate Software Wizard. This Wizard will help 
with activating the Basic System or any other software 
modules. 

  

Technical Support Information Collects and displays information about your computer 
and the Guard1 Plus installation. A report containing this 
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information can be printed. 

If you contact Technical Support for help, you may be 
asked to print and fax this report. This can help the 
technicians resolve problems. 

About Guard1 Plus Displays information about Guard1 Plus, including the 
version number and the license agreement. 

 

Status bar panes 

The status bar appears across the bottom of the main Guard1 Plus window. It displays information about the current 
state of the program, the logged in user if security is enabled, the current data file (or blank for the Master Data file), 
time and date, and other information. 

  If the status bar is not shown, select the View menu. The Status bar item will be unchecked. Select Status bar. A 
check  will appear next to this menu item, and the status bar will appear on the main window. 

From left to right, the status bar displays the following information in its panes: 

 

Icon Displays an icon relevant to the current status of the 
program.  indicates Guard1 Plus is ready or displaying 
information about an operation in progress or completed.  
indicates a warning message is being displayed.  indicates 
an error or other problem has occurred. 

If no message is displayed in the Message pane, the Icon 
pane will be empty. 

Message Displays any status messages as well as a progress bar 
for certain operations. Typically displays Ready when the 
system is idle. 

Security If security is enabled, this pane will display the currently 
logged-in user. Otherwise, this is empty. 

Current Data This pane will display Sample if the sample data is loaded, 
or the name of the data file if a backup or archive file is 
loaded. When the master data is loaded, this is empty. 

Record Count If the active (front-most) properties tab is showing a list, 
such as a button list or downloads list, this pane will 
display the number of items in the list. Otherwise, this is 
empty. 

Date Displays the current date as set in your computer’s 
Date/Time control panel. 

Time Displays the current time as set in your computer’s 
Date/Time control panel. 

 

Copyright and trademark information 

TimeKeeping Systems, Guard 1, Guard 1 Plus!, THE PIPE, Direct Downloader, Mobile Downloader, Modem 
Downloader and other TimeKeeping Systems products referenced herein are trademarks or registered trademarks of 
TimeKeeping Systems, Inc. 

Other brand and product names are trademarks or registered trademarks of their respective holders. 

 

Copyright 2000 - 2005 TimeKeeping Systems, Inc. All Rights Reserved. 

 

System Messages 

View Backup or Archive data 

While viewing backup or archived data, some features of Guard1 Plus are disabled. For example, you cannot 
download, delete or edit patrol data that has been downloaded. This preserves the integrity of the backup or archive 
data file. To enable all functions and features, return to the Master data by selecting the File menu, then select Use 
Master Data. 

Tell me more about viewing backup or archive data  

Error opening data 
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An error occurred while opening this data file. It may not be a valid Guard1 Plus data file or it may be damaged. Make 
sure the file you are attempting to open is a Guard1 Plus data file. If the file has become damaged, replace it from your 
most recent backup and try again. 

An error has occurred 

Guard1 Plus is unable to complete this operation. Please try again. If this is not successful, exit Guard1 Plus and 
restart the program, then try the operation again. If the problem persists, contact TimeKeeping Systems Technical 
Support by calling 216-595-0695, faxing 216-595-0991, or sending email to support@guard1plus.com. 

Error starting the Wizard 

The Wizard could not be started. The Wizard’s file may be damaged or missing. Please contact Technical Support for 
assistance. You will find contact information on the System  tab under the Technical Support Resources  node. 

Too many tabs open 

You have opened 10 properties tabs, which is the maximum allowed. Please close one or more tabs before attempting 
to open any new tabs. 

To close properties tabs, select the Close  icon  at the upper right of the tab. To close all tabs, right-click any 
properties tab, then select Close All Tabs or press F2. 

Do you want to save changes? 

You have made changes to the information on this tab, but have not yet saved these changes.  If you want to save the 
changes before the tab closes, select Yes. If you want to discard the changes and close the tab, select No. Select 
Cancel to dismiss the message and leave the tab open. 

Deletion confirmation - Security 

You are deleting a user name and password from the password list. Select Yes  to permanently delete this entry. 
Select No  or Cancel  to dismiss the message and leave the user name in the list. 

Password is missing 

You have enabled password protection, but have not entered a Supervisor password. You must either enter a 
Supervisor (and confirmation) password or uncheck the Use Password Protection  box. 

Confirmation password is required 

When setting up password protection, you must enter a password, then enter it again in the Confirmation Password 
field. This is to verify that the new password was entered correctly. 

Passwords don't match 

When setting up passwords, you must enter the password, then enter it again in the Confirmation Password  field. This 
is to verify that the password you want to use was typed correctly. 

The password and confirmation password you have entered do not match. Make sure you enter the same characters 
exactly, including upper and lower case characters. 

Password incorrect 

The password you have entered is not correct. Make sure you have selected the correct user name. When typing 
passwords, be sure to use the correct case – passwords are case-sensitive. 

A "user" name is required 

You must enter a name in the Name field before you can save the new password. Other "required" fields are 
Password and Confirmation Password. 

Tell me more about setting up passwords.  

Password is missing 

You must enter a password in the Password  field before you can save the new password. Other "required" fields are 
Name and Confirmation Password. 

Tell me more about setting up passwords. 

This user has already been added 

This user name already exists – it has previously been added. You can’t add it again. 

File name and location (path) required 

You must supply a file name and folder before you can continue. You may enter a folder and file in the field provided, 
or select the Browse button and select the file you wish to use. If you enter this information, the complete path is 
required. For example, for a backup file, you might enter a path such as C:\Program Files\Guard1 
Plus\Backups\Monday Backup.g1p. If this file does not exist, Guard1 Plus will create it for you. If it already exists, you 
will be asked if you want to replace the existing file. 

Tell me more about data maintenance.  
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File name and location (path) required 

You must supply a file name and folder before you can continue. You may enter a folder and file in the field provided, 
or select the Browse button and select the file you wish to view. If you enter this information, the complete path is 
required. For example, to view a backup file, you might enter a path such as C:\Program Files\Guard1 
Plus\Backups\Monday Backup.g1p. 

Tell me more about viewing or printing backup and archive files  

File already exists 

The file you are about to save already exists. If you want to replace the existing file with the new one, select Yes. 
Select No or Cancel if you want to enter a different name for the new file so that it does not replace the existing one.  

Replace file confirmation 

This operation will replace your master data with the data from the backup file. This means any data added to Guard1 
Plus since the backup was made will be lost. If you are sure you want to proceed, select Yes. Select No or Cancel to 
abort this operation. 

Could not display Web site 

The program’s Web site could not be displayed. There may be a problem with the site or with your Internet connection 
or setup, or there may simply be excessive Internet traffic. You can try again later to see if the site is available. If you 
have a dial-up connection to the Internet, make sure you are connected before attempting to view the Web site. 

Unable to display the Tip of the Day 

The Tip of the Day could not be displayed. The most likely cause is that the Tip of the Day file is either missing or has 
been damaged. You can turn off (disable) the Tip of the Day so that the error message does not appear. .  

System clock check 

Guard1 Plus has detected that your computer’s clock is set to a time earlier than the last time the program was run. 
This could indicate a problem with your computer’s clock. Please check the clock and reset the time and date if 
necessary. 

Data Maintenance reminder 

One or more data maintenance operations should be performed now. These reminders appear at intervals you can 
set. If you want to run the Data Maintenance Wizard now to perform these operations, select the Yes  button. Select 
No  to close the reminder message.  

Tell me more about data maintenance  

Restoring the Master data file 

You are currently viewing a data file that is not the Master file. The next time Guard1 Plus is started the master data 
file will be opened. 

You must type a name 

All nodes must have a name. Before you can proceed, you must enter a name for this item. 

Name must not exceed 255 characters 

The name you have entered is longer that 255 characters. You must enter a shorter name before you can save. 

Photo or map could not be found 

A photo or map (graphic file) previously added to this properties tab could not be found. This is the image used on the 
Photo sub-tabs on location properties or the Map sub-tab on rule properties. The image file may have been deleted 
from your hard drive, or the drive on which the file is located (such as a floppy or other removable, or a network drive) 
is not accessible. The photo can't be displayed. 

Select the Yes button to remove Guard1 Plus's reference to the file's location and clear all information from the Photo 
or Map sub-tab. You must then save the changes to the tab by selecting the Save icon  button on the tab’s toolbar. 

Select No to replace the reference with one to a temporary photo. When you restore the graphic file to its original 
location (or restore the network connection or removable media drive) the original image will be displayed the next 
time this sub-tab is opened. 

Tell me more about: 

Using pictures with location buttons.  

Adding maps to rules  

Do you want to save changes? 

You have made changes to one or more options, but have not yet saved these changes.  If you want to save the 
changes, select Yes. If you want to discard the changes and close the options window, select No. Select Cancel to 
dismiss the message and leave the options window open. 

Data Maintenance Module has expired 
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The Data Maintenance software module has expired. To continue to benefit from this module you must activate it. 
The Activate Software Wizard will help you with the activation process. 
. 

Changes take effect after Guard1 Plus is restarted 

The change you have made to the Launch the Keypad Module when Guard1 Plus starts checkbox will not take effect 
until the next time Guard1 Plus is run. If you want the change to take effect right away, exit Guard1 Plus, then restart 
the program. 

The location description cannot be empty 

You must enter a description in the begins with field for locations. Make the change, then select the Save button. 

The incident description cannot be empty 

You must enter a description in the begins with field for incidents. Make the change, then select the Save button. 

The officer description cannot be empty 

You must enter a description in the begins with field for officers. Make the change, then select the Save button. 

Number of digits must be unique 

One or more of the digits fields contain the same number. Each of these fields must have a unique number. You will 
not be able to save your settings if, for example, you have set both locations and incidents to 4 digits. Make the 
change(s) so each number field is unique, then select the Save button. 

Value must be unique 

The value you have entered has already been defined. You must use a unique value for the number of location, 
incident, and officer digits. Change this value so that it is unique, then select Next to continue. 

Open Archive 

Select an archive file, then select the Open  button. Guard1 Plus will close the current data file and open the selected 
archive. Note that archive files are opened as "read-only". You can view the archive data and print reports, but you 
cannot change the archive, nor can you download patrol data into the archive file. 

Select the Cancel  button to close this dialog box and leave the current data file loaded. 

Tell me more about viewing or printing archive files.  

By default, Guard1 Plus will look in the Archives folder for these files. If you have saved archive files in a different 
directory, you may need to select that folder from the Look in: list. 

Open Backup 

Select a backup file, then select the Open  button. Guard1 Plus will close the current data file and open the selected 
backup. Note that backup files are opened as "read-only". You can view the backup data and print reports, but you 
cannot change the backup, nor can you download patrol data into the backup file. 

Select the Cancel  button to close this dialog box and leave the current data file loaded. 

Tell me more about viewing or printing backup files.  

By default, Guard1 Plus will look in the Backups folder for these files. If you have saved backup files in a different 
directory, you may need to select that folder from the Look in: list. 

License file could not be found 

The file "License.txt" could not be found. This file is necessary for Guard1 Plus to run properly. 

To fix this you must run Setup from your Guard1 Plus CD-ROM or other media. This will reinstall or repair the file as 
necessary. 

Expand or collapse nodes 

Nodes typically have expand/collapse controls you can use to display or hide the items under a "parent", or higher-
level node. Select the  icon to expand a node and display the items under it. The icon will then change to . Select this 
icon if you want to collapse the node. If there is no icon next to the node, the node is empty. 

Main program window 

  
This view of the Guard1 Plus window shows the Downloads tab treeview (left pane) and several properties tabs  
(right pane). Drag the divider between the panes to change the width. The main menu bar is across the top, and the 
main toolbar is below that. The status bar is at the bottom of the window. 
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Glossary 

Activate Software Wizard 

Guard1 Plus is modular in design. When you first install the program, you have full access to all software modules 
during a trial period. This allows you to work with the Basic System, and also allows you to use modules that support 
readers and downloaders from several manufacturers, save and print custom reports with advanced formatting, set up 
rules for report processing, create custom "button keypads", and perform backups and other data maintenance. 

When the trial period expires Guard1 Plus will no longer run. You must activate the Basic System, which you can do 
at no charge. If desired, you can also activate other modules so that you may continue to benefit from system 
functionality that you had during the trial period. 

The Activate Software Wizard will describe the activation process, list the pricing for the various modules (except the 
Basic System, which is free), and help you contact TimeKeeping Systems to complete the transaction. 

To run the Activate Software Wizard: 

• Start Guard1 Plus. If the Welcome screen appears, select the Activate button. You can do this even after the trial 
period has expired. If the Welcome screen does not appear, select the Help menu. Select Activate Software 
Wizard. 

• You can also run this Wizard without starting Guard1 Plus. To do this, select the Windows Start button, select 
Programs, then Guard1 Plus, and then select Activate Software Wizard. 

Activation 

Guard1 Plus provides full functionality of all software modules free for a trial period that begins with the date of 
installation. After this trial period, the Basic System and all other software modules expire. If you wish to continue to 
use the Basic System or a module after it expires, it must be activated. The Basic System can be activated at no 
charge – this is free software. You can purchase and activate any module before or after it expires. This requires 
contacting TimeKeeping Systems, Inc. for the necessary activation code. The Activate Software Wizard will lead you 
through the process of purchasing and activating software modules. 

Add Devices Wizard 

This Wizard is used to add reader and downloader hardware to Guard1 Plus. If your hardware is connected to your 
computer, the Wizard can detect it and automatically install it for you. You can also use the Wizard to "manually" add 
devices. 

Add Locations Wizard 

This Wizard is used to add locations to clients, facilities, or groups. The Wizard will display a list of Unassociated 
locations. You can select any number of locations from the list to be added to a parent client, facility, or group. 

Archive Data File 

After you have collected weeks or months of patrol data, you may wish to remove the old data from your system. 
Archiving allows you to do that while still providing access to the old data. When you archive data, you use the Data 
Maintenance Wizard. In the Wizard you specify a date, and all patrol data in your system older than that date are 
moved from your master data file to the archive data file. You can open the archive and view or print this data any 
time. 

Archiving capabilities are part of the Data Maintenance module. This module is fully functional during the trial period, 
after which it will expire. To activate this module run the Activate Software Wizard. This Wizard will provide pricing and 
instructions. 

Assign Names Wizard 

The Assign Names Wizard is used to assign names and types to new data downloaded from readers. The Wizard will 
appear automatically when Guard1 Plus processes the data from the download. The Wizard asks a series of questions 
for each record (button, strip, station, or checkpoint) in the download. As you answer these questions, the Wizard 
collects the information and assigns a type and a name or description to each button. 

Attendant 

The Attendant is a component of the Guard1 Plus System that manages the downloading of data from your readers or 
remote devices. By default, the Attendant loads when Guard1 Plus is started. You can tell that the Attendant is loaded 
by noting its "guard" icon  in your Windows task bar, usually near the clock. The Attendant icon changes to show its 
status when downloading readers, adding buttons, etc. 

You can set several options to configure how the Attendant works. You have access to these options from the 
Attendant itself and also from within the Guard1 Plus program. 

Auto-answer Mode 

Before a modem can answer an incoming call, it must be placed in auto-answer mode. This is done by sending a 
setup "string" or command to the modem. External modems, such as those used with the Modem Downloader and 
other remote devices, typically have an "AA" LED to indicate when the device is in auto-answer mode. 



 45 

If your host computer is to answer calls and download from remote devices, the computer’s modem must be in auto-
answer mode. Guard1 Plus will attempt to make this setting for you. 

If your remote device is to answer calls from the host computer, the remote device’s modem must be in auto-answer 
mode. The Mobile Downloader can make this setting for you. 

Basic System 

Guard1 Plus consists of a number of software modules. The Basic System consists of the Facilities, Buttons, Basic 
Reports, Downloads, and System modules, and the Attendant. The Basic System provides downloading of THE PIPE, 
and printing of basic reports in one style. Optional modules include the Data Maintenance module, Rules and 
Advanced Reporting, Keypads module, and modules that support Detex, Morse, and Deister hardware. 

Batch (Reports) 

Guard1 Plus offers a wide variety of reports. You can customize most of these to include specific date ranges, filters, 
rules, etc. If you regularly produce a set of reports, you can create a batch "report" that includes all of these. When 
needed you can simply print the batch report, and all the separate reports included in the batch will print. If you print a 
large number of reports, printing them as a batch can save considerable time – you start the batch report, and while it 
prints you can do other work without waiting for each report to finish. 

Batch reporting is part of the Rules and Advanced Reporting module. This module is fully functional during the trial 
period, after which it will expire. To activate this module, run the Activate Software Wizard. 

Buttons 

Throughout the on-line Help the term button is used to indicate "touch button", "strip", "station", or "checkpoint", as 
used by the makers of the various readers supported by Guard1 Plus. Each has a unique icon in Guard1 Plus: touch 
button: , strip: , station: , checkpoint: . 

Buttons Tab 

Guard1 Plus makes extensive use of "tabs", similar in appearance to the tabs on file folders, in its interface. The 
Buttons  tab displays the buttons, strips, stations, and checkpoints in your system. 

Like most tabs in Guard1 Plus, the list is displayed in a hierarchical treeview. The Officer Buttons node on the treeview 
can be expanded to display the Officer buttons in your system. Each of the other nodes can be expanded to display 
buttons of the appropriate type. 

Clients 

The Facilities tab includes a Clients  node. If your organization provides security services to one or more clients, you 
can add clients to Guard1 Plus. Each client appears as a node under the Clients heading. Clients can include 
locations (patrol stops), one or more facilities and/or one or more groups. These facilities and groups help organize the 
client’s locations. These provide an intuitive method for organizing the locations that must be visited when making 
patrols for your clients. 

Com Port 

The Com port  is a connector on a computer (PC) through which serial data signals are routed. A Com port is required 
for connecting the computer to a local downloader.  For Guard1Plus the Com port may be a serial port or a USB port. 

Command Button, Command Pipe 

A Command PIPE is placed in a Modem Downloader to cause it to dial the host computer and download the patrol 
data. A command button is touched to the button port on the Modem Downloader to initiate dialing and downloading. 
Any PIPE can be a Command PIPE. Command Buttons may be selected from a list of incident and officer buttons. 
You set up Command PIPEs and Buttons on the properties tab for a Modem Downloader. 

Company Logo 

The Rules and Advanced Reporting module allows you to add your company’s logo to reports. You must create a 
computer file of the logo, and place the image file in the proper directory. For more information, open the on-line help 
and search for logo. 

The Rules and Advanced Reporting module is fully functional during the trial period, after which it will expire. To 
activate this module run the Activate Software Wizard.  

Contact 

You can add name, address, telephone, fax and email information to any client, facility, group, or location. This 
becomes the contact information for that parent item. If you have activated the Rules and Advanced Reporting 
module, you can specify that this contact information be included on reports. This allows you to easily address reports 
to specific individuals within client companies. 

Guard1 to Guard1 Plus conversion Wizard 

This Wizard will copy the button information from your Guard1 data file and load it into Guard1 Plus. The Wizard 
performs the necessary conversion so that you may continue to use the buttons you have in Guard1 with your new 
Guard1 Plus software. 
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The Wizard will copy each button’s ID number, the button type (location, incident, or officer), and the button’s 
description. No patrol (tour) data is copied. 

For instructions see the ReadMe.txt file that was included with the Wizard. 

Cover Sheets for Reports 

The Rules and Advanced Reporting module allows you to create cover sheets for your reports. These can contain 
custom addressing information for your clients, as well as your company’s logo and other information. For more 
information, open the on-line help and search for cover sheet. 

Two styles of cover sheets are available: Report Cover Sheet and Fax Cover Sheet. 

The Rules and Advanced Reporting module is fully functional during the trial period, after which it will expire. To 
activate this module run the Activate Software Wizard.  

Custom Button 

The Keypad module in Guard1 Plus allows setting up numeric button keypads for use with THE PIPE. Keypads contain 
12 touch buttons that represent the digits 0 through 9, plus Enter and Cancel keys. The patrol officer can then enter 
locations, such as room numbers, as well as incidents and officers by reading buttons on the keypad. 

You might define keypad locations to require four digits, and set the location prefix to "Room #". The patrol officer 
would enter read a location by touching THE PIPE to four buttons, for example "1", "9", "5", and "3", then touch the 
"Enter" button. When THE PIPE is downloaded, this would appear as a single custom button with the ID "CB# 1953", 
with the description "Room # 1953". 

Custom Report(s) 

Beginning with one of the available Standard reports, you can set a custom date range, appearance options, and 
filters. This modified version of the Standard report can be given a name and saved so that it can be used as needed. 
These saved reports are Custom reports. Custom reports appear on the Reports tab under the Custom Reports node. 
When a Custom report is for a client, facility, or group, the report will also appear under that parent item on the 
Facilities tab. 

Data maintenance 

The Data Maintenance module allows you to back up your patrol data so you can restore the file in case of data loss 
or other computer problems. You can also create archives of your patrol data and perform "tune ups" (integrity checks) 
on your data. 

The Data Maintenance module is fully functional during the trial period, after which it will expire. To activate this 
module run the Activate Software Wizard.  

Date Range 

When printing some types of reports, you can limit the patrol data included in the reports to patrols conducted over a 
period of days, weeks, or months. You can customize this period as desired by specifying the start and end dates 
along with  the first day of the week. 

For example, you may wish to print a Download report each week on Monday, and you want this report to show the 
patrols that were made during the previous week. To do this you would create a Download report with a date range of 
Last Week. 

You can also create custom date ranges, to print, for example, all patrol data between July 14, 1999 and July 31, 
1999. Any range of dates can be used, allowing you to see on your reports only the information needed. 

Default 

After the installation of Guard1 Plus, the settings found in any dialog box the first time it opens are the default settings. 
You can change most of the defaults and save these changes. These become the "new" default settings. 

Detailed Headings 

The Rules and Advanced Reporting module allows you to determine the headings used on your reports. If you 
choose to include Detailed headings in your reports, you will see the complete contact information for the report’s 
intended recipient (a client, for example).  

The Rules and Advanced Reporting module is fully functional during the trial period, after which it will expire. To 
activate this module run the Activate Software Wizard.  

Detection Method 

The detection method property setting on your downloader(s) determines whether Guard1 Plus can automatically 
detect when THE PIPE or other reader is placed in a downloader. The two detection methods are "When a reader is 
placed in a downloader" (insert detection) and "When I select ‘Download Now’" (manual download). 

If the detection method is set to insert detection, a reader will be automatically downloaded when it is detected. 
Guard1 Plus settings can be changed to manual download for downloaders do not support this automatic detection of 
readers. 
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Devices 

This is an all-inclusive term used to refer to readers, direct-connect downloaders, and remote downloaders. 

The Guard1 Plus Basic System supports THE PIPE, the Direct Downloader, the Mobile Downloader, and the Modem 
Downloader, from TimeKeeping Systems, Inc. Readers and downloaders from Morse, Detex/GCS, and Deister are 
supported by additional software modules. These modules are fully functional during the trial period, after which it will 
expire. To activate a module run the Activate Software Wizard.  

Divider 

The vertical line which separates the system pane (left side) and the properties pane (right side) of the main Guard1 
Plus window. This can be dragged left or right with the mouse to resize the panes. In the same way, you can resize 
the panes in the Help window. 

Also, the separator between the column headings on properties tabs that display lists. This can be dragged left or right 
to change the width of the columns. 

The mouse pointer changes to  when positioned over the divider or column separator. 

Download 

To transfer patrol data from a reader to your computer, or the patrol data from a reader after the download is made. 

Download Into Sample Data Wizard 

Guard1 Plus provides a sample data file. This is useful for training, experimentation, and learning about the program’s 
features. If the sample data file is loaded, and you download a reader, the Download Into the Sample Data Wizard 
will appear. This will help you decide what to do with the data. You can continue the download so that the data are 
stored in the sample data file, switch to the master data file and download the data there, clear the reader without 
downloading, or cancel, leaving the data in the reader. 

Downloader (Local) 

An electronic interface is required between a reader and the computer on which Guard1 Plus is running. This interface 
is the downloader. It is usually connected to a com (serial) port on the PC. Many downloaders support "insert detection 
", so that the data are automatically downloaded into Guard1 Plus when the reader is placed in the downloader. 

Guard1 Plus supports various types of downloaders, including Legacy, Direct, Plug and Play, and downloaders from 
Morse, Detex/GCS, and Deister. 

Guard1 Plus also supports downloaders which do not allow for insert detection, and can also be used with remote 
downloaders such at the Modem Downloader. 

Downloader (Remote) 

Patrol data can be downloaded from remote sites to the host computer at the main office or headquarters by using a 
remote downloader. The Modem Downloader is an example of such a product. Readers are downloaded into a 
Modem Downloader. Guard1 Plus can dial it via modem, and the patrol data  transferred to the host computer. It is 
also possible to set up Guard1 Plus so that the remote downloader can call the host computer and transfer its tour 
data. 

Guard1 Plus also supports local downloaders that are connected directly to the com (serial) port of your computer. 

Downloads Tab 

Guard1 Plus makes extensive use of "tabs ", similar in appearance to the tabs on file folders, in its interface. The 
Downloads  tab displays a list of the downloads you have made into Guard1 Plus. For each reader downloaded, the 
download will appear with its date and time. For devices such as the Mobile and Modem Downloaders, which can 
store downloads from multiple PIPE readers, The downloader device will be shown with the time and date it was 
downloaded. 

Like most tabs in Guard1 Plus, the list is displayed in a hierarchical treeview. A Mobile or Modem Downloader’s  node 
on the treeview can be expanded to display the  individual PIPEs’ downloads within it. 

Exception 

A rule violation at a location. On appropriate rule-based reports, an exception is generated only when the actual 
number of visits for a location is less than the expected count. If actual is greater than expected, it is not an exception. 

Facilities 

If your organization provides services that cover several buildings, Guard1 Plus can organize the location buttons (or 
strips, stations, or checkpoints) by individual facility. You can use this feature if you provide services for one or more 
clients with several locations, or if you provide in-house security and your organization has more than one building to 
patrol. This helps separate locations with similar names, and if you have activated the Rules and Advanced 
Reporting module, you can create rule-based reports that "filter " the included patrol data based on individual 
facilities. 
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Facilities Tab 

Guard1 Plus makes extensive use of "tabs ", similar in appearance to the tabs on file folders, in its interface. The 
Facilities  tab displays the clients, facilities, and groups in your system. If there are any Unassociated Locations in your 
system, they appear under this tab. 

Like most tabs in Guard1 Plus, the list is displayed in a hierarchical treeview. The Clients node on the treeview can be 
expanded to display the clients in your system. Each client can be expanded to show any facilities and groups 
associated with it, as well as the buttons, contacts, and rules associated with the client and its facilities and groups. 

Filter 

Filters are used to determine the patrol data that appear in various reports. You can use filters to include patrols made 
by specific officers, for example, so you can verify the progress of new employees. You can set up a filter to include 
only the most critical locations in your download reports, so you can tell at a glance if there are problems with these 
locations. 

Guard1 Plus provides great flexibility in setting up filters for reports. You can filter by location, incident, officer, or any 
combination. 

Filtering requires the Rules and Advanced Reporting module. This module is fully functional during the trial period, 
after which it will expire. To activate this module run the Activate Software Wizard.  

Global Default Date Range 

This is the default date range for any reports that require a date range to return data. Guard1 Plus ships with this 
default set to yesterday, you can override this setting at any time. 

Groups 

Guard1 Plus allows you to organize locations into named groups. A group can be subordinate to a facility or client if 
desired. Groups can be used to help you better keep track of locations requiring special attention, and  if you have 
activated the Rules and Advanced Reporting module, you can create rule-based reports that "filter " the included 
patrol data based on individual groups. 

Help System 

This help system uses a number of icons to indicate special topic: 

 This indicates a note with special information you should be aware of. 

 Indicates a loss of data could result from the action being described. 

 Used to indicate that data will be permanently deleted, or that multiple items will be effected by the changes being 
made. 

Help Tab 

Guard1 Plus makes extensive use of "tabs ", similar in appearance to the tabs on file folders, in its interface. The Help  
tab displays a number of buttons under a What would you like to do? heading. Each button will open the on-line Help 
system and display a topic as indicated by the button’s title. 

The buttons in the Help tab were designed to take you to the Help topics that will get you started with Guard1 Plus 
quickly or to topics you are most likely to use periodically. 

Host Computer 

When using Modem Downloaders or other remote downloaders, the host computer is usually located in a central 
security office or company headquarters. The host computer can make calls via modem to the remote downloader, 
and the tour data is transferred from the remote site to the host. Some remote downloaders can call the host, allowing 
for unattended data transfer. 

Incident 

An Incident button identifies a problem or other observation made by the officer. Incident buttons must be carried by 
officers during patrols. You can create duplicate sets of incident buttons to be carried by more than one officer at a 
time. Incident buttons have this icon . 

When an officer encounters a problem during a patrol, he or she would read the location button, then read an 
appropriate incident button. This would indicate the location and the incident found there when the reader is 
downloaded and reports are printed. 

Incidents can also be read from keypads made up of keypad buttons. The Keypad module allows the entry of numeric 
codes to represent incidents, as well as officers and locations. 

Insert Detection 

Guard1 Plus provides to methods for detecting readers. The Detection Method is a property of each downloader. 
Some types of downloaders can automatically detect when a reader is placed in the downloader, and automatically 
download the readers data. On the downloader’s properties tab, this is the When a reader is placed in the downloader 
option. This method is commonly referred to as "insert detection". 
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Some downloaders do not support insert detection. The detection method option for these types of downloaders 
defaults to When I select Download Now. 

ID Number 

Found on readers’ properties tabs, this is the serial number of a reader. Guard1 Plus gets this number automatically 
when a reader is found. You can’t alter the information in this field. 

In-house Services 

If you provide patrol services only within your own facility (or facilities), whether that’s a business, university or other 
school, government facility, or other organization, you are providing "in-house" services. If you have multiple buildings 
or sites to patrol, you may wish to organize your locations using facilities in Guard1 Plus. If you have a large number of 
locations, these can be further organized into groups. 

Generally, in-house security will not require the use of clients  within Guard1 Plus. 

Keypad 

The Keypad module in Guard1 Plus allows setting up numeric button keypads for use with THE PIPE. Keypads contain 
12 touch buttons that represent the digits 0 through 9, plus Enter and Cancel keys. Patrol officers carry the buttons for 
each keypad in wallets, attached to clipboards, etc. The patrol officer can then enter locations, such as room numbers, 
as well as incidents and officers by reading buttons on the keypad. 

For example, for hotel patrols you might define keypads to use four digits to represent locations, and prefix each 
location with "Room #". When making a patrol, an officer might stop at room number 1953. He would open his keypad 
"wallet" and use THE PIPE to read the four buttons that represent "1", "9", "5", and "3", and then read the button that 
represents "Enter". When that PIPE is downloaded, those buttons will be stored as a single location called "Room 
#1953". 

To set up a keypad you should first set up the definitions for the types of buttons in your keypads. The Keypad 
Module Setup Wizard provides assistance when making these settings. If you choose not to make these settings, the 
Guard1 Plus defaults will be used. You can create as many keypads as needed. 

Keypads are available during the trial period, after which they will not be displayed. To activate the Keypad module run 
the Activate Software Wizard.  

Keypads Tab 

Guard1 Plus makes extensive use of "tabs", similar in appearance to the tabs on file folders, in its interface. The 
Keypads  tab displays a list of the keypads you have added to Guard1 Plus. To view keypads, select the Keypads tab 
to bring it to the front. Right-click any keypad, and from the menu that appears select View. You can also simply 
double-click the keypad to view it. 

Like most tabs in Guard1 Plus, the keypad list is displayed in a hierarchical treeview. 

The Keypads tab is available during the trial period, after which it will not be displayed. To activate the Keypad module 
run the Activate Software Wizard.  

Keypad Button 

The Keypad module in Guard1 Plus allows setting up numeric button keypads for use with THE PIPE. Keypads contain 
12 touch buttons that represent the digits 0 through 9, plus Enter and Cancel keys. The buttons for each keypad would 
be carried by patrol officers in wallets, attached to clipboards, etc. Patrol officers can then enter locations, such as 
room numbers, as well as incidents and officers by reading buttons on the keypad. 

Keypad Module Setup Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent mistakes. Wizards appear automatically when needed. 

The Keypad module provides several settings that determine how keypads will function. You can alter these settings 
to adjust the Keypad module to your requirements. The Keypad Module Setup Wizard is used to make settings for 
keypads. When the first keypad is created, you will be asked if you want to run this Wizard. After running the first time, 
the settings are stored and the Wizard will not automatically run again. You can, however, run it from the Keypads tab 
on the Options screen. 

The Wizard is available during the trial period, after which it will not be displayed. To activate the Keypad module run 
the Activate Software Wizard. 

Legacy Downloader 

A small beige downloader, about the size of a deck of playing cards. These downloaders usually displayed THE PIPE 
logo on the front nameplate. These are no longer manufactured, and do not support insert detection. However, they 
can be used with Guard1 Plus. When adding these devices, be sure to enter the correct serial number into Guard1 
Plus, either in the Add Devices Wizard, or on the downloader's properties tab. Verify that the Detection Method 
displayed on the properties tab is set to When I select "Download Now". 
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"List" Type Reports 

Guard1 Plus can produce several types of reports. One of those types is the List reports. These are simple reports 
that show lists of buttons in your system. You can print a list of all buttons, or restrict the list to show only Location, 
Incident, Officer, Unassigned, or Unassociated Location buttons. 

Some features of List reports require the Rules and Advanced Reporting module. This module is fully functional 
during the trial period, after which it will expire. To activate this module run the Activate Software Wizard. 

Location 

A patrol stop. Locations are visited by officers, and the button, strip, station, or checkpoint installed at each location is 
scanned or read by the reader. 

Locations can also be read from keypads made up of keypad buttons. The Keypad module allows the entry of numeric 
codes to represent locations, as well as officers and incidents. 

Master Data File 

The Master data file is where all the information about locations, officers, incidents, clients, facilities, groups, and all 
downloaded patrol data are stored. In addition to the master data file, you can create backup and archive data files. 
Guard1 Plus also includes a Sample data file which you can use for learning the program and experimentation. 

Your daily patrol data should be downloaded into the Master data file. This file is always loaded when Guard1 Plus 
starts, so you can begin your normal, daily patrol work with it right away. 

Modem 

An electronic device that converts data from a computer into a signal that can be carried over telephone lines. At the 
other end of the phone connection another modem converts the signal back into data and sends it to a computer or 
Modem Downloader through the serial (COM) port. 

Numeric Button 

The Keypad module in Guard1 Plus allows setting up numeric button keypads for use with THE PIPE. Keypads contain 
12 touch buttons that represent the digits 0 through 9, plus Enter and Cancel keys. The buttons for each keypad would 
be carried by patrol officers in wallets, attached to clipboards, etc. Patrol officers can then enter locations, such as 
room numbers, as well as incidents and officers by reading numeric buttons on the keypad. 

Keypads are available during the trial period, after they will not be displayed. To activate the Keypad module run the 
Activate Software Wizard. 

Numeric Button Keypad Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent mistakes. Wizards appear automatically when needed. 

The Numeric Button Keypad Wizard is used to create keypads. It will guide you through the process of clearing THE 
PIPE, reading buttons for a keypad, downloading those buttons, and naming and saving the new keypad. 

The Wizard is part of the Keypads module, available during the trial period, after which it will not be displayed. To 
activate the Keypad module run the Activate Software Wizard.  

New Button Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent mistakes. Wizards appear automatically when needed. 

The New Button Wizard is used to add new buttons to Guard1 Plus. If this wizard is enabled (all wizards are enabled 
by default), it will appear whenever you touch a button that is unknown to the system to a Direct Downloader. Note that 
the Attendant must be running and enabled before you can add buttons to the system. The New Button Wizard leads 
you through the steps necessary to set the type (officer, location, or incident) and description of the button. 

This wizard can be disabled by selecting the Don’t show me this anymore checkbox to mark it on the last panel of the 
wizard. If the wizard is disabled, you can enable it by selecting Guard1 Plus Options from the program’s View menu. 
Select the Wizards tab, then click to place a check mark in the New Buttons wizard checkbox. Select Save, and the 
wizard will appear the next time you touch an unknown button to your Direct Downloader. 

New Contact Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent mistakes. Wizards appear automatically when needed. 

The New Contact Wizard will assist with adding contact information to clients, facilities, and groups. 

This wizard can be disabled by selecting the Don’t show me this anymore checkbox to mark it on the last panel of the 
wizard. If the wizard is disabled, you can enable it by selecting Guard1 Plus Options from the program’s View menu. 
Select the Wizards tab, then click to place a check mark in the New Contact wizard checkbox. 

New Client Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent mistakes. Wizards appear automatically when needed. 
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The New Client Wizard will assist with adding clients, and also with adding facilities and groups to clients. 

This wizard can be disabled by selecting the Don’t show me this anymore checkbox to mark it on the last panel of the 
wizard. If the wizard is disabled, you can enable it by selecting Guard1 Plus Options from the program’s View menu. 
Select the Wizards tab, then click to place a check mark in the New Clients wizard checkbox. 

New Facility Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent mistakes. Wizards appear automatically when needed. 

The New Facility Wizard will assist with adding facilities, and also with adding groups to facilities. 

This wizard can be disabled by selecting the Don’t show me this anymore checkbox to mark it on the last panel of the 
wizard. If the wizard is disabled, you can enable it by selecting Guard1 Plus Options from the program’s View menu. 
Select the Wizards tab, then click to place a check mark in the New Clients wizard checkbox. 

New Group Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent mistakes. Wizards appear automatically when needed. 

The New Group Wizard will assist with adding groups to Guard1 Plus. 

This wizard can be disabled by selecting the Don’t show me this anymore checkbox to mark it on the last panel of the 
wizard. If the wizard is disabled, you can enable it by selecting Guard1 Plus Options from the program’s View menu. 
Select the Wizards tab, then click to place a check mark in the New Clients wizard checkbox. 

Node 

When viewing any tab in Guard1 Plus’s left pane, the top-most or "parent" level for any group of items is called a node. 
For example, on the Buttons tab, you may have location, incident, officer, and unassigned buttons. These buttons will 
appear under the Location Buttons, Incident Buttons, Officer Buttons, and Unassigned Buttons nodes, respectively. 

Nodes typically have expand/collapse controls you can use to display or hide the items under a parent node. Select 
the  icon to expand a node. The icon will then change to . Select this icon if you want to collapse the node. If there is 
no icon next to the node, the node is empty. 

Notes Field 

This is a text entry field found on various properties tabs. Up to 255 characters can be entered, and a vertical scroll bar 
will appear when required. 

Officer Button 

An Officer button identifies an officer. It is usually kept by the officer on an ID badge or key ring. Officer buttons have 
this icon . 

Before the start of each patrol, the officer should read this button. This would indicate which officer made the patrol 
when the reader is downloaded and reports are printed. 

Officers can also be read from keypads made up of keypad buttons. The Keypad module allows the entry of numeric 
codes to represent officers, as well as incidents and locations. 

Password 

If security is enabled, a password must be entered when starting Guard1 Plus. If an incorrect password is entered the 
program will not start. 

Passwords can be set up to provide several levels of security, giving different user access to different sets of program 
features. At least one user must have "supervisor" access rights. This allows full access to the program, including 
setting up passwords for other users. 

Path 

When a file is saved in Windows, the destination of that file must be explicitly given. Typically, a file is saved on the C: 
drive, so the path name would begin with "C:\". The path may contain the names of one or more folders. For example, 
the default path for a backup file in Guard1 Plus is C:\Program Files\Guard1 Plus\backups\. This would be followed by 
the name of the backup file. Guard1 Plus will set the default path for you. You need only enter a path for a backup or 
archive file if you want to save it to a location other than the default. 

Patrol Data 

The data downloaded from one or more readers into Guard1 Plus. When one or more patrols are made with a reader 
and that reader is downloaded, you can view the patrol data from that download on the Downloads tab or in printed 
reports. 

Patrol Statistics 

The Rules and Advanced Reporting module allows you to include patrol statistics on your reports. If you choose to 
include statistics in your reports, you will see information about the number of rules processed, the number of time 
periods processed, the number of exceptions, etc. in the report footer.  
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The Rules and Advanced Reporting module is fully functional during the trial period, after which it will expire. To 
activate this module run the Activate Software Wizard.  

 

Plug and Play 

Plug and Play technology allows the Windows operating system to recognize when new hardware is attached to the 
computer. Windows will ask for the installation software, usually supplied on a floppy disk or other media. The Plug 
and Play Direct Downloader is an example of a Plug and Play device. 

You must shut down your computer and turn off its power, connect the Plug and Play Direct Downloader, then start the 
computer. Windows will find the downloader and ask for the installation disk. When this process is complete the 
downloader will be connected and ready for use. 

Properties Tab(s) 

Guard1 Plus makes extensive use of "tabs ", similar in appearance to the tabs on file folders, in its interface. 
Properties tabs will appear in the right pane of Guard1 Plus’s main window. These properties tabs will display 
information about buttons (or strips, stations, or checkpoints.), readers and downloaders, downloaded data, etc. Some 
properties tabs allow you to edit the displayed information, while others present the information for viewing purposes 
only. You can open a maximum of 10 properties tabs at one time. Right-click a tab to see a menu of options for closing 
tabs. 

Properties tabs have a tool bar across the top. This is where you will find buttons you can select to control various 
program functions. 

Setup Card 

Guard1 Plus can print these cards to help make adding new touch-buttons and installing them at the correct patrol 
stops fast and easy. The Setup Card includes fields in which you can write information about the client or facility 
(optional), button numbers, and a description of each button’s location. The buttons are attached to these cards with 
an adhesive dot. The cards of buttons are then taken into the field, and the buttons are removed from the cards and 
applied, which the same adhesive dot, to the patrol stop. 

The Setup Card is designed for use only with memory touch-buttons as used by THE PIPE. 

Read-only 

You can set up passwords that allow users to view the information in Guard1 Plus, but not make any changes. With 
read-only access, any feature that allows changing information or printing reports is disabled. 

You should set up read-only passwords when you don’t want specific users to make any changes to your Guard1 Plus 
data, but you want those users to be able to view information in the program. You can change access rights later as 
necessary. 

Reader 

Also called "data collector". Guard tour software requires a hardware device officers use to collect tour data. Data is 
read from Touch Memory buttons with THE PIPE, the world’s most rugged data collector. Guard1 Plus also supports 
readers from Morse, Detex/GCS, and Deister. These devices read stations, strips, or checkpoints instead of Touch 
Memory buttons. 

When an officer reads a button (or other station) with a reader, the button number is recorded within the reader, along 
with the date and time the button was read. This tour data is later downloaded into Guard1 Plus, which processes the 
data and produces reports. 

Remote Devices 

This is an all-inclusive term used to refer to remote readers and downloaders (those that connect via modem). 

Patrol data can be downloaded from remote sites to the host computer at the main office or headquarters by using a 
remote downloader. The Modem Downloader is an example of such a product. Readers are downloaded into a 
Modem Downloader. Guard1 Plus can dial it via modem, and the tour data is transferred to the host computer. You 
can also set up Guard1 Plus so that the remote downloader can call the host computer and transfer its tour data. 

Guard1 Plus also supports "local" downloaders that are connected directly to your computer. 

Report Style 

The Rules and Advanced Reporting module allows you to set styles for your reports. These are based on Microsoft 
Word templates that are included with Guard1 Plus. There are seven styles available, including "business", "classic", 
"contemporary", and more. Each has several style variations available. 

If you have not activated the Rules and Advanced Reporting module you can still print reports, but only the "dot 
matrix" style is available. 

The Rules and Advanced Reporting module is fully functional during the trial period, after which it will expire. To 
activate this module run the Activate Software Wizard.  
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Reports-only 

You can set up passwords that allow users to view the information in Guard1 Plus and print reports, but not make any 
changes. With reports-only access, all features that allow changing information are disabled, and only the Reports tab 
is available. The other tabs are not displayed. 

You should set up reports-only passwords when you want specific users to be able to print reports but have no other 
access to Guard1 Plus data. You can change access rights any time as necessary. 

Reports Tab 

Guard1 Plus makes extensive use of "tabs ", similar in appearance to the tabs on file folders, in its interface. The 
Reports  tab displays the reports available in your system. These include the Standard reports, and any Custom and 
Batch reports you may have created. 

To print reports, select the Reports tab to bring it to the front, expand the appropriate node(s) to find the report you 
want, then right-click the report. From the menu that appears, select Print. 

For more information about printing and customizing reports, see Reports tab - overview in the on-line help. 

Right-click 

Like Windows 95 (and later), Guard1 Plus makes extensive use of the mouse’s right button. When you see "right-click" 
in a help topic, this means you should place the mouse pointer (cursor) over the specified item and click once with the 
right mouse button. This will usually cause a pop-up menu to appear. Move the mouse pointer over an item on this 
pop-up menu, then click with the left mouse button to select that menu item. 

If your mouse has been configured for left-hand use, the "right" mouse button may actually be on the left. Technically, 
this is the "context menu" button. 

Rule 

Rules allow you to establish accountability among the officers or guards making patrols and determine the number of 
times a location was visited in a given time period. A rule acts as a filter for patrol data. When you print reports, the 
rules you have defined are processed. Several types of reports are available. Some include only the patrol data that 
"pass" the rule(s), while others include only the patrol data that are exceptions to the rule(s). You can create as many 
rules as you like, and they are all processed when reports are printed. 

To create a rule, you can provide a time and date range (the rule’s schedule), a specific number of visits or "hits" 
required for each site (the rule’s detail), and optionally a graphic of a map indicating the patrol route or directions to the 
patrol site. 

Rules are part of the Rules and Advanced Reporting module. This module is fully functional during the trial period, 
after which it will expire. To activate this module run the Activate Software Wizard.  

Rule-based Reports 

After you have added one or more rules to a client, facility, group, or location, you can print reports that process the 
rule(s). If you create a rule for a client that sets a required number of officer visits to the client’s locations, you can then 
print a Rule Exception report for that client. The rule will be processed, and the printed report, based on that rule, will 
show any locations that were visited fewer than the number of times specified in the rule. 

Other rule-based reports include the Rule Itinerary report, Rule Summary report, and Rule Activity report. 

Rule-based reports require the Rules and Advanced Reporting module. This module is fully functional during the trial 
period, after which it will expire. To activate this module, run the Activate Software Wizard. 

Sample Data File 

Guard1 Plus includes a Sample data file which you can use for learning the program and experimentation. You can 
download sample data, view downloads, print reports, create rules, set up clients and facilities, etc. 

Any data from readers downloaded into the Sample data file will not be available for your routine reports. Your daily 
patrol data should be downloaded into the Master data file. This file is always loaded when Guard1 Plus starts, so you 
can begin your normal, daily patrol work with it right away. 

Software Modules 

The Guard1 Plus system includes a number of software "modules" that provide additional functionality or 
enhancements to basic features. Enhancements include Rules and Advanced Reporting. Additional features include 
Morse, Detex, and Deister reader/downloader support, data maintenance, and keypads. 

These modules are included on your Guard1 Plus CD-ROM, and are available to you during the trial period. These 
modules will expire after the trial period, but can be purchased and activated at any time. To activate a module, run the 
Activate Software Wizard.  

 

Status Bar 

The status bar appears across the bottom of the main Guard1 Plus program window. The status bar always shows the 
current date and time as set in your computer’s Date/Time control panel. Current status of other items is shown in the 
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status bar. This includes informational and error messages, whether the Sample data is currently loaded, the user 
name if security (password protection) is used, and a record count if a list of records is shown on a properties tab. 

You can hide the status bar if desired. Select the View menu, and you’ll see the Status Bar item is checked. Select 
Status Bar. The status bar will disappear. You can return the status bar by selecting this same menu item again. 

Support Subscription 

When a software module is purchased, technical support is available for a period of 30 days. Additional technical 
support may be purchased in one-year increments (subscriptions). Technical support is available only to customers 
who have a current support subscription. 

Supported Readers and Downloaders 

The Guard1 Plus Basic System supports THE PIPE and Direct Downloader, and the Mobile  and Modem  
Downloaders from TimeKeeping Systems, Inc. With additional software modules, Guard1 Plus can support: 

Morse Watchman Boss 2000 series and Charger/Interface , 

Detex/GCS Series 89 and 92 DAU and DTU , 

Deister de Watch , WKTrans , MagII , de Prox , and de Trans . 

These modules are fully functional during the trial period, after which they will expire. To activate modules run the 
Activate Software Wizard.  

System Tab 

Guard1 Plus makes extensive use of "tabs ", similar in appearance to the tabs on file folders, in its interface. The 
System  tab displays the devices (reader and downloader hardware) and software modules installed in Guard1 Plus. 
Select the System  tab to bring it to the front. You will see nodes for Readers, Downloaders, Software, and Technical 
Support Resources. Expand any of these nodes to view their contents. Double-click any item to display a properties 
tab with more information about that item. 

Tabs 

Guard1 Plus makes extensive use of "tabs", similar in appearance to the tabs on file folders, in its interface. On the 
left-pane of the main window are the "permanent" system tabs. Select any tab to bring it to the "front" and display its 
contents. System tabs display hierarchical lists of items that can be expanded or collapsed. If password protection is 
enabled some of the system tabs may not be displayed. This is dependant upon the access rights of the individual 
user.  

The right pane displays properties tabs, which give more information about selected items on the system tabs. Up to 
10 properties tabs can be displayed at one time. These can display lists, data fields, buttons, and other controls. 

Some properties tabs have sub-tabs. These appear across the bottom of the properties tab and provide access to 
additional features, options, or views of data. Select any sub-tab to display the additional information. 

You will also find tabs used on some dialog boxes to provide access to various option settings. Select a tab to bring 
that section of the dialog box to the front. 

Toolbars 

Guard1 Plus makes use of several toolbars. There is a toolbar across the top of the main window (just below the menu 
bar). Each properties tab also has a toolbar across the top. A toolbar contains buttons with icons to indicate the 
function of each button. If you "hover" the mouse pointer over a toolbar button (don’t click) a "tool tip" will appear 
showing the name of that button. 

You can hide the main toolbar if desired. Select the View menu, and you’ll see the Toolbar  item is checked. Select 
Toolbar. The main toolbar will disappear. You can return the toolbar by selecting this same menu item again. 

Tip of the Day 

When the program starts it presents a Tip of the Day, which offers helpful information and tips about using the 
program. If you’d rather not see these tips you can turn off this option. If the Tip of the Day does not appear when 
Guard1 Plus starts, you can turn it back on. This may be useful when you have new officers who will be learning to 
use the program. 

Tour Reports 

Guard1 Plus can produce several types of reports, including Tour reports. These are reports that show downloads of 
patrol (tour) data. You can print all downloads, individual downloads, restrict the report to specific date range, or filter 
by Location, Incident, or Officer. 

Some features of Tour reports require the Rules and Advanced Reporting module. This module is fully functional 
during the trial period, after which it will expire. To activate this module run the Activate Software Wizard.  

 

Treeview 

This term describes lists of items, such as clients, facilities, and groups, or downloads. A treeview is hierarchical in 
nature – the list will have multiple levels indented below higher level nodes. 
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The nodes in a treeview have expand/collapse controls you can use to display or hide the items under a parent node. 
Select the plus icon  to expand a node. The icon will then change to a minus . Select this icon if you want to collapse 
the node. If there is no icon next to the node, the node is empty. 

Trial Period 

Guard1 Plus provides full functionality of the Basic System and all software modules free for a trial period. This trial 
period begins the first time you run Guard1 Plus. After this trial period, the Basic System and all other modules 
expire. The Basic System can be activated at no charge – this is free software. You can purchase and activate any 
software module before or after it expires. 

Activating the Basic System or a module requires running the Activate Software Wizard. 

Types of Buttons/Strips/Checkpoints/Station 

Note: throughout this help system, the various types of stations used by the supported readers are referred to 
as "buttons". When you see the word "button" used, please consider this to be equivalent not only to the 
Dallas Touch Memory used by THE PIPE, but also to the strips, checkpoints, and stations used by other 
readers. 

• An Officer button identifies an officer. It is usually kept by the officer on an ID badge or key ring. Officer buttons 
have this icon . 

• A Location button identifies a location. It is installed at a checkpoint to be visited during officers' patrols. Locations 
use these icons: 

Buttons:  

Strips:   

Checkpoints:   

Stations:   

• An Incident button identifies a problem or other observation made by the officer. Incident buttons must be carried 
by officers during patrols. You can create duplicate sets of incident buttons to be carried by more than one officer at 
a time. Incident buttons have this icon . 

• An Unassigned button is one that has not yet had a type and description or name assigned. When new buttons are 
added or when a reader that contains buttons unknown to the system is downloaded, these buttons are unassigned. 
Guard1 Plus provides wizards to help you assign types and descriptions to these buttons. The following icons are 
used: 

Unassigned buttons: . 

Unassigned strips: . 

Unassigned checkpoints: . 

Unassigned stations: . 

• An Unassociated location is a Location button that has not been associated with (assigned to) a client, facility or 
group. It has, however, been given a description. These buttons are often called "orphaned" locations. They can be 
associated with clients, facilities, or groups at any time. Unassociated locations have this icon:   

Types of Reports 

Guard1 Plus provides a large number of reports, divided into several "types". These are: 

• Listings  

• Tour reports  

• Rule reports  

• Cover sheets and "other" reports 

• Batch reports  

 Advanced reports functionality is required for some types of reports. This is available during the trial period or after 
the Rules and Advanced Reporting module is activated. Otherwise some features and options are disabled 
("grayed out"). Run the Activate Software Wizard for more information. 

For more information about each type of report, see Reports tab - overview in the on-line help. 

Unassigned Buttons 

These are buttons that have been added to Guard1 Plus but have not yet been assigned descriptions or types. When 
a reader is downloaded, any buttons in the downloaded data that are not known to Guard1 Plus can be assigned when 
the download is processed, or they can be left unassigned. To use these buttons you must give them descriptions and 
set the type to Location, Incident, or Officer. 

Unassociated Location 
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An Unassociated location is a Location button that has not been associated with (assigned to) a client, facility or 
group. It has, however, been given a description. These buttons are often called "orphaned" locations. They can be 
associated with clients, facilities, or groups at any time. 

USB 

Short for Universal Serial Bus, an external bus standard that supports data transfer rates of 12 Mbps. A single USB 
port can be used to connect up to 127 peripheral devices, such as mice, modems, and keyboards. USB also supports 
Plug-and-Play installation and hot plugging.  

Starting in 1996, a few computer manufacturers started including USB support in their new machines. It wasn't until 
the release of the best-selling iMac in 1998 that USB became widespread. It is expected to completely replace serial 
and parallel ports 

Watermarks 

The Rules and Advanced Reporting module allows you to add your company's logo to reports. You must create a 
computer file of the logo, and place the image file in the proper directory. For more information, open the on-line help 
and search for logo. 

Once the logo file is available, you can select to have this image appear in a light shade "behind" the text on your 
printed reports, much like an embossed watermark appears on paper. 

The Rules and Advanced Reporting module is fully functional during the trial period, after which it will expire. To 
activate this module run the Activate Software Wizard.  

Welcome Screen 

When you start Guard1 Plus for the first time you will see a Welcome screen. The information displayed on this screen 
varies and depends on the state of Guard1 Plus. 

• In Trial Mode the Welcome screen shows the number of days remaining in the trial period. 

• In Expired Mode the screen indicates that all modules have expired, and the Start button is disabled. You can run 
the Activate Software Wizard by selecting the Activate button. The Wizard will tell you how to proceed. 

• In Registered Mode the screen will indicate which, if any, modules are not active. If desired, you can mark the 
Don’t show me this anymore box, and the Welcome screen will no longer appear when you start Guard1 Plus. 

For more information about starting Guard1 Plus, the various start-up modes, and the Welcome screen, see Starting 
Guard1 Plus - the Welcome screen, in the on-line Help. 

What's This Help 

What’s This Help allows you to quickly learn about fields, checkboxes, options, toolbar buttons, and other controls in 
Guard1 Plus. To use What’s This Help, select the What’s This Help icon  on the main toolbar. The mouse pointer will 
change to a similar icon. Place this pointer over any item on the screen and click the mouse. A small window will 
appear with a description of the control you selected. 

The Attendant also includes What’s This Help. To activate it select the  icon on the Attendant’s title bar. 

Wizard 

Wizards are "helpers" that provide assistance when you need to perform specific actions within Guard1 Plus. These 
simplify complex operations and help prevent users from making mistakes. Wizards appear automatically when 
needed. 

Guard1 Plus has a number of wizards. Some of these are always available, while others can be disabled (turned off) 
when you decide they are no longer necessary. They can be enabled again at any time, which can help when you train 
a new user. 
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